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2. Installing SpiraTeam®

This section outlines how to prepare your system for installation of SpiraTeam®, how to actually install
the software using the provided installation package, and finally how to ensure that your web-server is
correctly configured to ensure secure operation.

The first sub-section will outline what hardware and software configurations are supported and the exact
installation sequence for the different versions of Windows Server. The second sub-section will explain
how to load the SpiraTeam® software onto the server, and discuss common problems and solutions.

The minimum hardware and software requirements for running the SpiraTeam® system are:

Server Requirements

Requirement Minimum Specification

Processor: Intel® or AMD® x86 or x64 compatible processor
Memory: 2 GB, 4 GB recommended

Operating System: Windows Server 2012 R1 & R2 (recommended)

Windows Server 2008 R1 & R2 (recommended)
Windows Server 2003 R1 & R2
Windows 8, 7, Visa, XP Professional* (for demoing)

Service Packs: Windows Server 2003 SP2

Database: Microsoft SQL Server 2014
Microsoft SQL Server 2014 Express Edition
Microsoft SQL Server 2012
Microsoft SQL Server 2012 Express Edition
Microsoft SQL Server 2008
Microsoft SQL Server 2008 Express Edition
Microsoft SQL Server 2005
Microsoft SQL Server 2005 Express Edition

Web Server: Internet Information Services (11S) 5.1 or higher
ASP.NET Web Extensions 4.0 or higher

Client Requirements

Requirement Minimum Specification

Web Browser: Internet Explorer 8.0+

Mozilla Firefox 3.0+

Google Chrome (Desktop and Android)
Apple Safari 3.0+ (Desktop and iOS)
Opera 18.0+

Other Components: Microsoft Excel 2003+ (optional)
Microsoft Word 2003+ (optional)
Microsoft Project 2003+ (optional)

*Note that SpiraTeam® can be loaded onto either Windows Server or Professional editions, provided that
the 1IS web-server is installed and that SQL Server is available as a database engine. However Windows
Vista (except Ultimate edition) and Windows XP Professional can only support a maximum of 5
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concurrent user web sessions. In general unless there are only going to be a couple of client machines
hitting the server, we recommend using Windows Server 2008 or 2012.

2.1. System Prerequisites

Assuming that you have already installed the appropriate version of Microsoft Windows onto your
computer (or that has been pre-installed for you), you need to then make sure that the various
prerequisites have been correctly added to your installation before trying to install SpiraTeam®. The
SpiraTeam® installer will check to ensure that the various prerequisites are in place, and will abort the
installation if any are missing, indicating to you what action needs to be taken.

We recommend that you install / configure the prerequisites in the following order:
Install the .NET Framework v4.0

Install SQL Server 2014, 2012, 2008 or 2005

Install the latest version of Internet Explorer that your server OS allows

Ensure that IS is installed

YV V Y VY

Ensure that ASP.NET 4.0 is enabled

2.1.1. Install the .NET Framework v4.0

On Windows Vista, Windows 7 and Windows 2008 Server installations, Microsoft .NET Framework v4.0 is
usually installed as part of the factory configuration, whereas on earlier operating systems, you might
need to manually add the .NET 4.0 components to the factory configuration. On Windows 8 and Server
2012, Microsoft .NET Framework 4.5 is installed which is fully compatible.

To see which version of the Microsoft .NET framework installed, open up Windows Explorer® and
navigate to C:\WINDOW S\Microsoft.NET\Framework and then the subfolders listed will indicate which
version(s) of the framework you have installed:

=l |) Microsoft.MET

+ | ) assembly

=l [ Framewaork
) v1.0.3705

NET Frameworks

# [ vl 14322 1.0, 1.1, 2.0, 3.0,

# (3 v2.0,50727 3.5 & 4.0 are installed
# ) v3.0

4 ) w3.5

# |3 v4.0,30319

To install the .NET Framework, launch Internet Explorer and enter the URL:
https://www.inflectra.com/CustomerArea. Once you have logged-in to the customer area, under the “My
Downloads” section there will be hyperlinks to download and install the appropriate version of the .NET
Framework (version 4.0 at time of writing). Click on the option to download and install the .NET
Framework, and follow the instructions provided. Once you have completed the install, verify that the
installation was successful by looking in the “Administrative Tools” folder as illustrated above. You also
need to make sure that .NET 4.0 has been installed if necessary.

Please make sure that the Full .NET 4.0 Framework is installed and not just the .NET 4.0 Client Profile.
You can check which is installed by going to Start > Control Panel > Programs & Features and then
looking for the different .NET 4.0 Framework components that are installed:
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—

-.?'-Micrusnft MET Framework 4 Client Profile
—-?‘-Micrnsuﬁ MET Framewaork 4 Bxdended
B Microsoft .MET Framework 4 Multi-Targeting Pack

If you only see the “Microsoft .NET Framework 4 Client Profile” and not the “Microsoft .NET Framework 4
Extended”, then you need to install the additional .NET 4.0 components that are needed for server-based
applications such as SpiraTeam to run.

2.1.2. Install SQL Server 2014, 2012, 2008 or 2005

Install the appropriate version of the database software, following the instructions provided with the
installation. We recommend SQL Server Express Edition® for most users. This free version of SQL
Server will offer sufficient performance for most installations and can be easily downloaded from either
the customer area of our website (http://www.inflectra.com/CustomerArea) or directly from the Microsoft®
web-site at http://www.microsoft.com/express/sql.

2.1.3. Install Internet Explorer

Install the latest version of the Internet Explorer web browser that is supported by your version of
Windows. You are free to use Internet Explorer, Mozilla Firefox, Apple Safari, Google Chrome or Opera
with SpiraTeam®. Other browsers may work with SpiraTeam®, but they have not been exhaustively
tested for compatibility by Inflectra®.

2.1.4. Ensure that lIS is installed

On Windows Server OS installations, IIS is usually installed as part of the factory configuration, whereas
on Windows workstation OS installations, you typically need to manually add the components to the
factory configuration. The steps that you need to take to verify its installation are listed below for each
operating system family:

a) Windows XP or 2003 Server

To check if you have IS installed, click Start > Control Panel > Administrative Tools. Under the
“Administrative Tools folder”, you should see an icon for “Internet Information Services”. If you don’t see
this icon, then it means that you need to add IIS to your computer:

@ Component Services

g Computer Management

Data Sources (ODBC)

Event Viewer

Local Security Policy

Microsoft \MET Framework 1. 1 Configuration

Microsoft .NET Framework 1.1 Wizards ) L
Derformance Indicates IS is installed

Services

Internet Information Services

BEEERFFOODE

Server Extensions Administrator
¥ MetaEdit 2.2

To install 1IS, you need to click Start > Control Panel > Add or Remove Programs, then choose the option
to “Add / Remove Windows Components” as illustrated below:
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Check the box marked either “Internet Information Services (11S)” or
the <Next> button to install the missing Windows components. Once the installation has completed, 1S
will now be installed on your system. To verify that this is the case, type http://localhost into the address
bar of Internet Explorer on your computer. You should see a screen displaying the initial IIS startup page:

“Application Server”, and click
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1.
2.
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4. Chek Internet Information Services,

Chek Start, and then deck Risn.

Ini the Open text box, type inetmgr. 115 Manager
appears,

From the Help menu, dick Help Topics.

Windows XP 1IS Default Page

b) Windows 7, Vista or Windows Server 2008

Windows 2003 Server 1IS Default Page

If you don't see this page, but instead see an IIS error page (e.g. Internal Server Error 500), please refer
to Appendix A — Troubleshooting IIS to fix your IS installation before following the rest of this installation

guide.
On Windows 2003 Server you may also need to go into the Web Service Extensions folder and make

sure that ASP.NET 4.0 is marked as ‘Allowed’. If you receive an HTTP 404 (Page Not Found) error when
running SpiraTeam® then it usually means that ASP.NET 4.0 is marked as Prohibited.

To check if you have IS installed, click Start > Control Panel > Administrative Tools. Under the
“Administrative Tools folder”, you should see an icon for “Internet Information Services (lIS) Manager”. If
you don't see this icon, then it means that you need to add IIS to your computer:



http://localhost/
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On Windows 7 or Vista, to install IIS, you need to click Start > Control Panel > Programs and Features,
then choose the option to “Turn Windows features on or off”. This will bring up the list of features and
roles that can be configured on the server:

-
Windows Features E@g

Turn Windows features on or off (7]

To turn a feature on, select its check box. To turn a feature off, clear its check
box. A filled box means that only part of the feature is turned on.

| FTP Server -
[H |, Web Management Tools
= @ | World Wide Web Services
= [ | Application Development Features
| NET Extensibility
L. Asp
| ASP.NET
L, cal
| ISAPI Extensions
. ISAPT Filters
| Server-SideIncludes
=) | |, Commaon HTTP Features
| Default Document
| Directory Browsing
. HTTP Errors f
|, HTTP Redirection
. Static Content
|, WebDAV Publishing
m W L Health and Diannnstics 2

m

On Windows Server 2008, you need to click on Server Manager, then under the “Roles” heading,
choose the option to “Add Role” followed by selecting the new role “Web Server / 1IS”. Then click “Next” to
bring up the role configuration screen:

Select the role services ko install for \Web Server (115):

Role services: Descripkion:

Web Server provides suppork For
7 C i Installed HTML Weh sites and optional support:
B ommol'! eatures (Installed) for A5P.MET, ASP, and WWeb server
Static Content {Installed) extensions, You can use the Web
Defaulk Document (Installed) Server ko host an inkernal or external
Directary Browsing (Installsd) ‘Web site or to provide an environment
HTTP Errors (Installed) for c_Iengopers to create Web-based
applications,

EEERE

HTTP Redirection (Instaled)

pplication Development {Installed)

ASPLMET (Inskalled)

MET Extensibility (Installed)

ASP

Gl

I5API Extensions {Installed)

ISAPL Filkers (Installed)

[ server side Includes —
Health and Diagnostics {Installed)

Security (Installed)

Performance (Installed)

nagement Tools {Installed)

115 Management Consale {Installed)

115 Management Scripts and Tools {Installed) LI

il = e b mwiime (Taekallodt

I

B @

HEOOER

(=g NE]
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|

More about role services




Make sure that the following features are enabled:

» Common HTTP Features
> Static Content
> Default Document
> HTTP Errors
> HTTP Redirection
>» Application Development
> ASP.NET
> .NET Extensibility
> ISAPI Extensions
> ISAPI Filters
>» Management Tools
> 1IS Management Console
> IIS Management Service

To verify that this 1S is now installed, type http://localhost into the address bar of Internet Explorer on
your computer. You should see a screen displaying the initial IIS startup page:

1IS7

internet information services Wtany,

fox

c) Windows 8 or Windows Server 2012

To check if you have IS installed, click Start > Control Panel > Administrative Tools. Under the
“Administrative Tools folder”, you should see an icon for “Internet Information Services (11S) Manager”. If
you don't see this icon, then it means that you need to add IIS to your computer:

& Defragrment and Optirmize Drives 25202 418 P Shortcut

@5, Disk Cleanup T255202 4:22 P Shortout

[ Event Wiewer TSN 420PM Shorkcut

|& Internet Information Services (I15) Manager  7/25/2012 415 PRd Shortcut

@. ISCE Initiator Internet Information Services (I15) Manager enables you to co
Ezlﬂ Lacal Security Palicy control, and troubleshoot 115 and &SP MET,

QDBC Data Sources (32-hit) TFARS2M2 29 PM Shortout

QDBC Data Sources (Bd-hit) TS M7 425 PR Shortcut

On Windows 8, to install IS, you need to click Start > Control Panel > Programs and Features, then
choose the option to “Turn Windows features on or off”. This will bring up the list of features and roles that
can be configured on the server:
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Turn Windows features on or off

To turn a feature on, select its check box, To turn a feature off, clear its
check box Afilled box means that only part of the feature is turned on,

L ASPMET 45
[w] L) WVCF Services
O | Active Directory Lightweight Directory Services
[ Hyper-¥
¥ Internet Explorer 10
=10 L Internet Information Services
[] 1) FTP Server
[=] 1 WWeb Management Tools
o= L World Wide Web Services
[w] 1) Application Development Features
[=] || Common HTTP Features
m [m] 1 Health and Diaannstic N

QK || Cancel |

On Windows Server 2012, you need to click on Server Manager, then under the “Roles” heading,
choose the option to “Add Role” followed by selecting the new role “Web Server / 1IS”. Then click “Next” to
bring up the role configuration screen:

Roles Description
Wolume Activation Services (Not installed) A Application Development provides
4 W] Web Server (II5) infrastructure for developing and
4 Web Server hosting Web applications. Use these
4 [m] Common HTTE Features features to create Web content or
Default Document extend the functionality of I1S. These
Directory Browsing technologies typically provide a way
HTTP Errors to perform dynamic operations that
Static Content result in the creation of HTML
HTTP Redirection output, which IIS then sends to fulfill
WebDAY Publishing (Mot installed) client requests.

Health and Diagnostics

(]
[m] Performance
(]

I
|
I Securi
"=
NET Extensibility 3.5
MNET Extensibility 4.5
Application Initialization (Mot installed)
ASP (Mot installed)
ASP.NET 3.5

|<Previou5|| Mext > | | Remove || Cancel

Make sure that the following features are enabled:

>» Web Server (lIS)
>  Web Server

» Common HTTP Features
> Default Document
> Directory Browsing
> HTTP Errors
> Static Content
> HTTP Redirection

» Application Development
> .NET Extensibility 3.5




.NET Extensibility 4.5
ASP.NET 3.5
ASP.NET 4.5
ISAPI Extensions
> ISAPI Filters
>» Management Tools
> 1IS Management Console
> IS Management Service
>» .NET Framework 4.5 Features
> .NET Framework 4.5
> ASP.NET 4.5
> WCF Services
>» HTTP Activation
» TCP Port Sharing

>
>
>
>

To verify that this 1S is now installed, type http://localhost into the address bar of Internet Explorer on
your computer. You should see a screen displaying the initial IIS startup page:

(S

£7 Windows Server
Internet Information Services 8.0

microsoft.com/web

2.1.5. Ensure that ASP.NET is installed

Now that you have both IIS and .NET installed, you need to make sure that the Active Server Pages
(ASP.NET) components that allow IS to access the .NET framework have been correctly configured. If
you installed .NET after IS then ASP.NET is typically configured for you, but if you installed IIS
afterwards, then further manual steps may be necessary. The settings are different depending on which
version of Windows you are using:

a) Windows XP or 2003 Server

To verify that ASP.NET has been correctly configured, click on Start > Control Panel > Administrative
Tools > Internet Information Services to launch the IS administrative console:
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T g w w
*§ Internet Information Services

File  Acton View Help
& Exffza) 2

Internet Information Services

Mame

| Path

- B SANDMAN (ocal computer)
—-{Z7] web Sites

. MDefault Web Site

+- ¥ Default SMTP Virtual Server

& 115Help
L@ 5eripts

Ea _wti_hin
a Printers

c:windowshelplishelp
C:\Inetpub\Scripts

C:'Program Files\Comman Files\Micr. ..
C:\WINDOWS Wweb\printers

Expand the name of the web-server (marked as local computer), expand the “Web Sites” folder, right-click
on “Default Web Site” and choose the “Properties” link. This will bring up the IIS configuration dialog-box
with the ‘Virtual Directory’ tab highlighted. Then click on the ‘ASP.NET’ tab if it is listed:

SpiraTest Properties

HTTP Headers
Virtual Directory

Custom Emars
Documents

ASP.NET

Directory Security

When connecting to this resource, the content should come from:
(@) A directory located on this computer
() A share located on anather computer

() Aredirection to a URL

Local Path:

[ Seript source access Log vists

[¥] Bead Index this resource
[T wiite

[ Directory browsing

Application Settings

Application name: Spira Test

CMSubversion'ProjectsInflectra Trunk\F

Remove

Starting poirt : <Default We..\SpiraTest
Execute Pemissions: Scripts only hd
Application Protection:  Medium (Pooled) A

SpiraTest Properties

Virtual Directony
HTTP Headers

Documents
Custom Emors

Directony Security
ASP.NET

ASP.MET version:
Virtual path:
File location:
File creation date:

File last modffied:

|

‘,-"SpimTest

‘C “Subversion'Projects\Spira Team. Trunk.Spira

‘9;‘23,-’2011] 1:29:55 PM

\wzafzmu 1:29:55 PM

If ASP.NET 4.0 is correctly configured you will see the ASP.NET tab, and it will list the ASP.NET version
as being ‘4.0.30319’ as illustrated above. If you don't see this tab, you either don’t have ASP.NET
configured, or you have an earlier version of ASP.NET (v1.1 or v2.0) configured.

To configure ASP.NET 4.0 for an existing IS website, you need to open up Windows Explorer and
navigate to the folder containing the .NET Framework. So, for example, if you have .NET Framework v4.0
installed, you would navigate to C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319. Now, you need
to open up a Windows command prompt by clicking Start > Programs > Accessories > Command Prompt.
This will open up the command prompt window:
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\WWINDOWS\system32\emd. exe
Fle Edt Vien Fovorites Tools Help " Soft Windous RF [Uersion 5_.1.26001
opyright 1985-2001 Microsoft Corp.
(€L P O seach Foiders | [T31]~ :\Documents and Settings:\Adam Sandman>cd “C:“\WINDOWS\Microsoft.NET\Franeuork.vd.d.38319"
(2 C:WINDOWS \WMicrasoft NET Frameworkv4.0.30319 ¥ ﬂm \WINDOUS\Microsof t .NET\Framework\w4.8.38319>aspnet_regiis.exe -i
Folders X Mame ~ ~
) Medis o] 21033
2 ) MaosoftNET () ASP.NETWebAdminFies
# () assembly O Cenfig
= &) Framework CMoE
£ v1.0.5705 2 msBuid
® DviLL432 el
@ £ v2.0.50727 DRedistiist
® D vao O sstuntade
& £ vas s
= £ va0/30318 () Temporary ASP.MET Fies
o 1033 CIWeE
H () ASPNETWebAdninFies 1) _DateOradeCientperfCounte...
® ) Config
@ mor
£ MsBuld
® S
D) RedistList
i () SetupCache
= 2sa =
B ) Temporary ASP.NET Fles [n) NetworkingPerfCounters v2h [y,
B O wer Mo ) >
312 objects (Disk free space: 7.53 GB) 127MB '$ My Computer 4 »

Now change the directory in the command window to the folder name in windows explorer (i.e. type
cd C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319 where the version number matches the
version number of the framework you have installed). Once you have changed the directory to the
appropriate folder, simply type aspnet_regiis.exe —i to configure ASP.NET. You can now verify that
ASP.NET has been installed by checking the IIS management console (as described above).

For 64-bit versions of Windows, please use C:\WINDOWS\Microsoft. NET\Framework64\v4.0.30319
b) Windows Vista, 7 or 2008 Server

To verify that ASP.NET has been correctly configured, click on Start > Control Panel > Administrative
Tools > Internet Information Services (11S) Manager to launch the 1IS administrative console:

U'i" INFLECTRASVR04 Home

Wy Start Page

SR 1omLe TR asvRDS (1L Bk 7 nl”
L # applcation Pocls ASPNET
@) Skes

o &, FL 2 [

NET NET JNET Trust Apphizstion  Connection  Machine Key  Pages and Providers  Session State  SMTP E-mal
Compdation  Gobalzation Levels Settings Seings Conitrols
ns
N =0 i = T =N = 1y, i =
' = - it ) a e
Autheriication Authonization  Compression Dwfauk Carectory Emor Pages Faled Request  Hander HTTF Redinect HTTP IPv4 Address
Russ Documert Browsing Tradng Rules  Mappings L and Domal, ..
g 7 . )
u k=l 4 ¥ i A Ry
154PT and CG1  TSAPT Fikers Legging MIME Types  Modules Qutput Sarver Worksr
Restrictions Cathing Certificates Frocedses

Management

h @ @ i

Faature 15 Manager  [I15 Manager  Management Shared
[,eleoaton Parmissions Users Service (Ol'flﬂ-llﬁlm

You should see a section called “ASP.NET” occupying the top third of the 1IS screen. If not, then you
need to go back to section 2.1.3 and make sure that you chose the option to install ASP.NET when
installing IIS.

c) Windows 8 or 2012 Server

To verify that ASP.NET has been correctly configured, click on Start > Control Panel > Administrative
Tools > Internet Information Services (11S) Manager to launch the 11S administrative console:
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You should see a section called “ASP.NET” occupying the top third of the 1IS screen. If not, then you

need to go back to section 2.1.3 and make sure that you chose the option to install ASP.NET when
installing IIS.

2.2. Installing the Software

Now that all the prerequisites have been correctly installed, you are now ready to install SpiraTeam® onto
your system. To perform the installation, you will need the installation package downloaded from the
Inflectra® website, the name of the organization that the software is licensed to, and the actual license key
code which will be available in the customer area of the Inflectra® website.

To start the installation, double-click on the SpiraTeam® installation package (it will have a filename of the

form SpiraTestPlanTeam-vX.X.X.X.msi), and the Windows Installer will display the following dialog
box:

2]

-
ﬁ SpiraTeam Setup

Welcome to the SpiraTeam
Setup Wizard

The Setup Wizard will install SpiraTeam v4.0.0.0 on your
computer. Click Mext to continue or Cancel to exit the Setup
Wizard,

inflectra”

| <gack | Next> | [ cancel |

If you are upgrading from an earlier version of SpiraTeam®, the dialog box will be similar except that it will
instead let you know that you are upgrading from an earlier version to the current one:




ii% SpiraTeam Setup E I

Welcome to the SpiraTeam
Setup Wizard

The Setup Wizard will upgrade the version of SpiraTeam on
waur computer to vw4,0,0.0, Click Mext ko continue or Cancel
ko exit the Setup Wizard,

inflectra”

Cancel |

< Back

In this instance the installer will update the program files on your computer and migrate your data into the
new version seamlessly. If for any reason you don’t see the upgrade message and you have an existing
installation, don’t continue, but instead contact Inflectra® customer support first. This will ensure that
your existing data is not overwritten by a clean install.

In the case of an upgrade, the system will make a temporary backup of your database to the
C:\Users\[UserName]\AppData\Local\Inflectra folder, so you need to make sure you have at least twice
the disk space available on the C:\ drive as the size of your existing database. If you want to specify a
different temporary location, please set the TST_WORKING_FOLDER Windows® environment variable
to the location you wish to use instead.

In either case, click the <Next> button to start the installation wizard which will gather information from
you regarding how you want to setup the system, before actually installing the web-server files and
database components. The next page of the installation wizard will display a list of all the required pre-
requisites and whether the installer could find them or not:

ﬁ SpiraTeam Checking Premquisite_ u

erifying Prerequisites —— -
i spiraTeam
——

Checking to make sure prerequisites installed

The list of prerequisites is displayed below. Please fix any errors before continuing
with the installation. Please dick on the details button to learn how to correct.

@ Microsoft Internet Information Services (Web Server) Details
@ Microsoft ASP.NET Web Server Extensions (4.0.30319) Details
@ Microsoft NET Framework 4.0,30319 Extended Details
Ignore
[ <Back [ mMext> | [ cancel |

If any of the prerequisites were not correctly installed, the installer will display a red cross icon next to the
missing component(s). If this happens, please refer to section 2.1 for installation of any prerequisites. If
for any reason you have the prerequisite installed but the installer was not able to find it (this can
occasionally happen on certain environments), click the <lgnore> button to proceed with the installation.
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Once the prerequisites have been correctly installed, clicking <Next> will bring you to the next page in the

installation wizard:

i'e!rl' SpiraTeam License Agreement

End-User License Agreement

Please read the following license agreement carefully

aTeam

INFLECTRA SOFTWARE END USER LICENSE AGREEMENT

IMPORTANT: THIS SOFTWARE EMD USER. LICENSE AGREEMENT
(I EULAD ) IS A LEGAL AGREEMENT BETWEEN YOU AMND
INFLECTRA. READ IT CAREFULLY BEFORE COMPLETING THE
INSTALLATION PROCESS AND USING THE SOFTWARE. IT
PROVIDES A LICENSE TO USE THE SOFTWARE AND COMTAINS
WARRANTY INFORMATION AMD LIABILITY DISCLAIMERS. BY

IMQTALL M ARDLIQURE THE @OETVWADE Wil ADE CORIEIDRAIN

()1 do not accept the terms in the License Agreement

l < Back “ MNext = ] l Cancel

The next screen in the installation wizard outlines the SpiraTeam® End User License Agreement (EULA).
Please read this carefully as it describes the legal contract between you — the user of the software — and
Inflectra® Corporation, the developer and publisher. Once you have read the agreement and understood
your rights and obligations, select the radio button marked “I accept the terms in the License Agreement”

and click the <Next> button.

The following screen will be displayed:

i'é" SpiraTeam Setup
Choose the Product being Installed T -
Choose the name of the product that you are installing: 1 eam
. SpiraTest
' est A complete quality assurance and test management
system with integrated defect tracking.
B SpiraPlan
P’an An essential tool for planning and managing complex
projects in a collaborative environment.
.| SpiraTeam
' eam Comprising SpiraTest and SpiraPlan in one integrated
suite, manages the complete application lifecyde.

x

You need to choose the product that you will be installing — SpiraTest®, SpiraPlan® or SpiraTeam®. This

is important because the license key for each product is different.
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Once you have chosen the product, the following screen will be displayed:

i'e!rl' SpiraTeam Setup x

Customer Information T -
Please enter your customer information eam
User Name:
|Joe Bloggs
Organization:
|Inﬂectra Corporation
{Must match the Organization name the License was issued to)
License Key:
I < Back “ Mext = ] I Cancel I

You need to enter your full name, the organization that was issued the software license, and finally
the full hexadecimal license key that was provided with the software. Once you click <Next>, the installer
will verify that all three were entered, and that the license key matches the product being installed and
that it matches the organization name. The installer will warn you of any discrepancies, but will allow you
to proceed; however after installation, the system will not operate until a correct license key is entered.

If for any reason you are unable to get the provided license key to work, please contact Inflectra®
customer support immediately and they will resolve the issue.

After clicking <Next>, you will be given the choice of installation to perform:

i'é" SpiraTeam Setup x

Choose Setup Type Team

Choose the setup type that best suits your needs

Complete Installation

Installs the full application and all the required database files.
Recommended for most users,

Application Onby
Installs only the application program files. This is useful if you
glready have the database installed on another server.

Custom Installation

Allows users to choose which program features will be installed
and where they will be installed. Recommended for advanced
_ users,

ga/‘:

By default, the installer will install all of the SpiraTeam® features onto the target system, so we
recommend choosing “Complete Installation”, which will both install the complete system — application
and database. For advanced users who want to change the folder to which the system is installed (by
default it is C:\Program Files\SpiraTeam), change the name of the database created (by default it
will be SpiraTeam) or to prevent the installation of the optional web-services data integration modules,
you can choose the “Custom Installation” option, which allows you to change those settings prior to
installation.

The “Application Only” installation is useful when you need to move the application to a different server,
but want to leave the database installed on the same server. In this case you can use the “Application
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Only” installation on the new server, and once the installation is completed, change the name of the
database pointed to in the “Web.Config” file to the existing database server.

This manual assumes that the “Complete Installation” option is chosen, in which case the following
screen is displayed:

i'é" SpiraTeam = ] 8
Select A Virtual Directory .
Select the web site virtual root ’ eam

This will install SpiraTeam in the following virtual directory.

To install to this virtual directory, dick "Mext”. To use a different virtual directory, enter the
name below.

\irtual Directory |SpiraTeam

This screen allows you to change the name of the web-site URL that will be user to access the system.
By default, users would need to type into their browsers: http:/<server name>/SpiraTeam. Should you

want to have a different name — other than SpiraTeam — change the name in the Virtual Directory box,

otherwise simply accept the default name and click <Next>. Note: The installer will check to make sure
that the name you have chosen is not already in use, and will warn you if it is.

Upon clicking <Next>, you will be taken the database connection screen:

i& SpiraTeam = g

Select A Database

Select the database to install on Team

The installer will now collect the information about your SQL Server database.

Flease enter the name of the database server, and the login/password for a
system-administration account that will be used to create the database objects.

(®) windows Authentication () 5QL Server Authentication

Server |5ANDMAN\5QLE><PRE55
Login |sa
Password |
Install Sample Projects (7]
[ Cancel ‘ I < Back I I Mext = ]

You can connect to the SQL Server database using either Windows Authentication or SQL Server
Authentication, and the process is slightly different for each mode:

2.2.1. Windows Authentication

This is the easiest option when the application and database will be residing on the same server. In this
case, choose the “Windows Authentication” option and the Login/Password boxes will be disabled. In this
case, the installer will connect to the database using your current Windows login to create the application
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database objects, and SpiraTeam® will connect to the database during normal operation using either the
ASPNET or NETWORK SERVICE Windows accounts (it depends on the version of the operating
system).

2.2.2. SQL Server Authentication

This is the easiest option when the application and databases will be residing on different servers across
the network. In this case, choose “SQL Server Authentication” and provide a SQL Server Login that has
Database Owner (DB-Owner) permissions — e.g. the built in System Administrator (SA) account. The
installer will use this DB-Owner account to create the database objects, and SpiraTeam® will use a
special login (called SpiraTeam by default) for normal application operations.

2.2.3. For Either Mode

In the “Server” box, you need to enter the name of the Microsoft SQL Server instance that is running on
your system; the installer will default it to the hosthame of the server (which in many cases will be
correct). The easiest way to find out the database server name is to open up the SQL Server
Administrative console (typically by clicking Start > Programs > Microsoft SQL Server > Enterprise
Manager) and look for the name of the server.

For SQL Server 2005/2008 Express edition installations, the Server name is usually the name of your
computer followed by \SQLEXPRESS”, so for example, if your computer is called MyComputer, the
server name would be MyComputen\SQLEXPRESS. Omitting the second part (called the instance name)
would lead to a “host not found” error.

You can also choose whether to install the sample projects or not — typically we recommend installing the
sample projects for evaluation installations and excluding them for production installs.

Once you have entered the various pieces of information, click <Next>. The installer will attempt to
connect to the database using the provided information, and it will display an error message if any of the
information is incorrect. Assuming the information is correct, the following screen will be displayed:

i'g";" SpiraTeam = a

Advanced Database Configuration

Please spedfy the following database options Team

The installer will now let you specify the advanced database configuration settings.

Flease choose the name of the database login, database name and database user that will be
created by the installer.

Database Login |SAI‘-JDI'r1AI‘-l VASPNET
Database Name |Spi|'aTeam
Database User |Spi|'aTeam
@,"
I Cancel ‘ I < Back ‘ I Mext > ‘

This page lets you customize the name of the database login, database name and database user that the
application will create. If you chose the “Custom Installation”, then the fields will be editable, otherwise
they will be read-only. Also if you chose “Windows Authentication” then the Database Login field will be
set to the built-in Windows account associated with ASP.NET for the specific operating system being
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installed on (and cannot be changed). Once you have reviewed this page and made any changes, you
should click <Next> to proceed:

L -
i SpiraTeam Setup !

aTeam

Ready to Install
The Setup Wizard is ready to begin the Complete installatiort

Click Install to begin the installation. If you want to review or change any of your
installation settings, dick Back. Click Cancel to exit the wizard.

l < Back “_ Install | l Cancel ]

Click the <Install> button to actually begin the process of installing SpiraTeam® onto your system. If you
are installing SpiraTeam® onto a version of Windows that has the User Access Control (UAC) enabled,
then you will first be prompted to confirm that you want to install a new piece of software. Click the option
that confirms you want to proceed with the install;

ﬁ_’ User Account Control

Do you want to allow the following program to install software on t
computer?

@ Program name:  d4fb22cl.msi
verified publisher: Inflectra Corporation

~

Change when these notifications appear

Click the “Yes” button to confirm that you want to install the software package.
The installer will then display a progress bar that gradually fills as the installation proceeds:

i'e!«'* SpiraTest Setup X

Installing SpiraTest -] B [ Test-

Please wait while the Setup Wizard installs SpiraTest, This may take several
minutes,

Status:

Cancel
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Once the installation is complete, the following message will be displayed:

i'-.\!“ SpiraTeam Setup l

Completing the SpiraTeam
Setup Wizard

Click the Finish button ta exit the Setup Wizard,

inflectra”

Cancel

= Back

Click the <Finish> button to complete the installation.

Congratulations! You have successfully installed SpiraTeam® onto your system. If you type
http://localhost/SpiraTeam into your browser you should see the SpiraTeam® login page, as illustrated in
the SpiraTeam® User Manual. If for any reason you don’t see the login page, please refer to Appendix A
— Troubleshooting IIS or contact Inflectra® Technical Support using one of the methods described at our
website http://www.inflectra.com/Support.

2.3. Security Considerations

The Microsoft Internet Information Services (11S) web-server and SQL Server database are powerful tools
to managing web-based applications. However it is important to make sure that they are correctly secured
to prevent unauthorized access to applications being hosted on them. This is a fast changing field and
beyond the scope of this guide to address, however we recommend reading the following article for
details on how to secure IIS:

http://www.iis.net/learn/manage/configuring-security

In addition to the steps outlined in this article, it is important to note that by default, all web pages served
by IS using the HTTP protocol are unencrypted, and as such, the usernames and passwords used by
SpiraTeam®to log into the application can be read by network sniffing tools. If you are using SpiraTeam®
purely within an intranet environment, this may not be an issue. However if you are externally hosting
SpiraTeam® onto a publicly accessible website, we recommend installing a Secure Sockets Layer (SSL)
encryption certificate, and restricting all web-traffic to the secure HTTPS protocol instead.



http://localhost/SpiraTeam
http://www.inflectra.com/Support
http://www.iis.net/learn/manage/configuring-security

3. System Administration

Now that you have successfully installed SpiraTeam®, this section of the guide outlines how to perform
the typical system-wide administrative tasks necessary for setting up projects in the system, managing
users and verifying the license information. To perform these tasks, you need to login to the system with a
username that has “System Administration” permissions. The special “administrator” username is created
by the installer for this very purpose. You should initially login to SpiraTeam® with the username
administrator, and the password PleaseChange. It is recommend that this password be changed as
soon as possible to something that is secure yet memorable by clicking on the “User Profile” link — see
the SpiraTeam® User Manual for more details.

Once you have logged in as the administrator, you need to click the “Administration” link which can be
found in the main SpiraTeam dropdown menu in the top-left of the screen:

I Internal Projects

My Page
My Timecard

Administration

SR = =

This will display the Administration home page:

My Page | My Timecard |

Role: Project Owner

¥ Projects

‘ S View [/ Edit Projects
View / Edit Projects
> Edit Project G’_UU S The following projects have been created in the system. To edit an existing project, please click on the 'Edit link
Project History Changes To create a new project, click on the [Add] button.
Data Tools
Project Name A ¥ Project Group Y Creation Date A ¥ Active AY DAY Operations.
» Users ( | s v \ =) e v R[]
» Custom Properties Legacy Application Extemnal Projects. 1-Dec-2005 No PRO00004 > Select | Edit| Copy| Delete
. Library Information System Internal Projects 1-Dec-2005 Yes PR000001 > Select| Edit| Copy | Delete
» Incidents Sample Application One Internal Projects 1-Dec-2005 Yes PR000002 > Select | Edit| Copy | Delete
¥ Requirements Sample Application Two Extemnal Projects 1-Dec-2005 Yes PROOD003 | > Select | Edit| Copy | Delete
R

} Notifications
» Documents
P System

} Integration

The Administration home page is divided into two main areas — the left hand navigation bar that contains
links to all the available administration options (grouped under headings) and the main pane that displays
the available settings for the selected option. By default, the “View/Edit Projects” administration screen
will be displayed in the main pane.

The options available to you in the left hand navigation bar will vary depending on your level of
administrative privileges. If you have the “system administration” privilege granted, then all the options will

be available, whereas if you are just a “project owner”, only those options relating to managing a specific
project will be available.

When you first install the system, the three main tasks you will need to perform as the system
administrator are creating/editing projects, creating/editing users and then adding the users as members
of the various projects. These tasks typically need to be performed before any other users can use the

system, since there will be no logins or projects available other than the sample ones provided during the
installation.

Each of the individual administrative options is described in turn below:
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3.1. Projects

3.1.1. View/Edit Projects

The following screen is displayed when you choose the “View/Edit Projects” link from the Administration
sidebar navigation:

View / Edit Projects

The following projects have been created in the system. To edit an existing project, please click on the 'Edit’ link
To create a new project, click on the [Add] button.

Project Name A ¥ Project Group AW Creation Date A¥ Active A IDAY Operations
L J (oA - M | &) - v) PR

Legacy Application External Projects 1-Dec-2005 No PRO000D4 > Select | Edit| Copy | Delete
Library Information System Internal Projects 1-Dec-2005 Yes PR000001 = Select| Edit| Copy | Delete
Sample Application One Internal Projects 1-Dec-2005 Yes PRO0O000D2 > Select | Edit| Copy | Delete
Sample Application Two External Projects 1-Dec-2005 Yes PRO0000O3 > Select | Edit| Copy | Delete

[» Filter |(» Add ][> Clear Filter |

This screen displays the list of projects in the system (both inactive and active) together with their project
group, date of creation and active status. Clicking on either the “Select” link in the right-hand column or
the name of the project will change the currently selected project to one clicked, and any project-specific
administration tasks will be applied to this project.

You can filter the list of projects by either choosing an active status, project group, or entering a portion of
the name or date into the appropriate text box. When you click the <Filter> button, the list of projects will
be filtered by the criteria you entered. You can clear the filter selection by clicking the <Clear Filters>
button. To sort the list of projects, just click on the appropriate arrow icon located in the header row of
each field (one each for ascending / descending) In addition, the list of projects is paginated into groups
of fifteen (15). You can step through the different pages by clicking the page numbers at the bottom of the
project list.

To permanently delete a project, you should click the “Delete” link to the right of the project details. This is
irreversible and will delete all the artifacts associated with the project. If you want to temporarily delete a
project, simply set its Active flag to ‘No’ instead. To make a copy of a project to reuse its test cases,
releases, test sets and requirements, simply click the “Copy” link to the right of the project. Note that this
will not make a copy of any historical information, test runs or incidents.

To add a new project to the system, simply click the <Add> button at the bottom of the project list, and a
new screen will be displayed that allows you to enter the new project information:

Edit Project Details | New Project
<< Back To Project List
Please review the information listed below and make any changes if necessary.
Once you have finished, click [Update/Insert] to confirm them.
Project Name:™ |
Description [-Fot-  ¥|[-s=- v| B U = | Ty | — 0o
Project Group:* | Default Group v)
Web Site (
Template:* ® Default O Based on Existing Project
Choose the default template will load the standard workflows and incident lists. Chaosing an existing project as the template will copy across that project's custom
properties, workflows and incident fields for use in the new project
Active:* [ves v)
» Insert ||» Cancel

You need to enter a name for the project (which cannot be the same as any already in use); select which
project group it belongs to and optionally enter a detailed description and/or web-site URL. You should
initially make sure that the project is marked as “Active”. In addition, you can choose to either use the
“default template” or to use an existing project as the template. Using an existing project as the template
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will copy across the workflows, user membership, custom properties, document types, document folders,
data synchronization and other configuration settings that you want to reuse in the new project. Once you
are satisfied with the information, click the <Insert> button to actually create the new project.

In a similar way, to edit the details of an existing project, simply click the “Edit” hyperlink in the right hand
column of the project list box, and you will be taken to the following screen that allows you modify the
project details:

Edit Project Datalls | Library Information Systam
E List

armation listed below and make any changes if secessany
shed, dick [Update/nser] to confinm thiem

Project Name:" ([ eary Information System
Desexiption Foed V[ se- v R U|EEa|iSicEE| A —epgDe@

Sample application that allows usars to managa baaks, authars and landing racords for a typical branch Bbeary

Project Group:® | intemal Projects v
Wizh Siler wowrw libraryinformalionsystem ong

Deefault Based on Existing Project

Choese the default template will lad the standard werkflows and Incident lists. Choosing an existing project as the template will copy across that project’s custom
properties, workflows and incldent flelds for use In the new project.

Active:” es L

[+ Update |[- Cancel |

On this screen you can edit the name, description, project group, website URL and active status. Once
you have made the necessary changes, click the <Update> button to commit them. If you decide that you
want to ignore the changes, click the <Cancel> button and the changes will be discarded.

3.1.2. Edit Project Groups

The following screen is displayed when you choose the “Edit Project Groups” link from the Administration
sidebar navigation:

Edit Project Groups

The following project groups have been created in the system. To edit an existing project group, please click on the 'Edit' link
To create a new project group, click on the [Add] button.

Project Group Name A ¥ Web Site 4 ¥ Default AV Active AV DAY Operations

[ J \ | A v [~Am- V] PG| |

Default Group Yes Yes PGDOD0O0T = Edit |
External P No Yes PGO0D0OD3 > Edit | Delete
nternal Pr: http-/iwww libraryinformationsystem org = No Yes PG00DDD2 > Edit | Delete

[» Filter ][+ Add | [+ Clear Filter |

This screen displays the list of project groups in the system (both inactive and active) together with their
web site URL, date of creation and active status. Project Groups are used to relate projects that are in the
same department/division/organization or are for a common customer, client, etc. When projects are in
the same group, a user that is a member of the project group can see the special Project Group
Dashboard that displays key metrics from all the projects in the group combined. Also such users will
have observer-level access to the contained projects without needing to be explicitly added to each
project.

You can filter the list of project groups by either choosing an active status, or entering a portion of the
name, web-site or date into the appropriate text box. When you click the <Filter> button, the list of project
groups will be filtered by the criteria you entered. You can clear the filter selection by clicking the <Clear
Filters> button. To sort the list of project groups, just click on the appropriate arrow icon located in the
header row of each field (one each for ascending / descending) In addition, the list of project groups is
paginated into groups of fifteen (15). You can step through the different pages by clicking the page
numbers at the bottom of the project list.
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To permanently delete a project group, you should click the “Delete” link to the right of the project group
details. Any projects contained in the group will not be deleted, but instead just moved to the default
project group. There has to be at least one project group in the system at all times, so the project group
designated as the ‘default’ one will not be available for deletion.

To add a new project group to the system, simply click the <Add> button at the bottom of the project
group list, and a new screen will be displayed that allows you to enter the new project group information:

Project Group Details | New Project Group
<< Back To Project Group List

Please review the information listed below and make any changes if necessary
Once you have finished, click [Update/Inseri] to confirm them.

Name:*

Description: [~ Font - V|[-ses- V| B I U

Web Site: (

Active:® [ves v'|

Default:* (1o v |

You need to enter a name for the project group and optionally enter a detailed description and/or web-site
URL. You should initially make sure that the project group is marked as “Active”. In addition, you can
choose to make this project group the default one (meaning that it cannot be deleted and projects get
added to it when their groups are deleted). Once you are satisfied with the information, click the <Insert>
button to actually create the new project group.

In a similar way, to edit the details of an existing project group, simply click the “Edit” hyperlink in the right
hand column of the project group list box, and you will be taken to the following screen that allows you
modify the project group details:

Project Group Details | Internal Projects
=< Back To Project Group List

Please review the information listed below and make any changes if necessary
Once you have finished, click [Update/Insert] to confirm them.

Name:* [Internal Projects

Description: ",Fum, v'H'”swze" Y| BZIU

SEEE || —epno@

Contains the library project and sample application one

Web Site [www. libraryinformationsystem.org

Active:® |Ygs v ‘
Default:* | Mo v ‘
[» Update |+ Cancel

On the top part of this screen you can edit the name, description, website URL, active status and default
status. Once you have made the necessary changes, click the <Update> button to commit them. If you
decide that you want to ignore the changes, click the <Cancel> button and the changes will be discarded.

In addition, the lower part of the screen allows you to view/edit the users that are members of the group
and also see which projects are in the group:

a) Group User Membership

This tab allows you to see which users are members of the group and which group role they have:
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User Membership Project List

v Full Name User Name Project Group Role
O Fred Bloggs fredbloggs | Group Owner v |
System Administrator administrator [ Group Owner v
P

[» Update |(» Add |[» Delete |

The two project group roles are “Executive” and “Group Owner”:

>» Executive — This role allows the user to see the dashboard for this project group, which contains
all the key metrics for the contained projects displayed in an aggregated manner. Please see the
SpiraTeam User Manual for more details on this dashboard. In addition, the user is automatically
granted ‘observer’ permissions for all the projects in the group.

» Group Owner — This role consists of all the permissions granted to the “Executive” role above,
but in additional allows the user to make changes to the Project Group itself in the Administration
section.

To change the role of an existing project group member, just change the role in the drop-down list and
click [Update]. To remove a member from the group, just select the appropriate checkboxes and click
[Delete]. Finally, to add a new user to the group, click on the [Add] button:

Add Project Group Membership | Internal Projects
<< Back To Project Group Membership

The following users are NOT members of this project group.
Please select a role for the users you want to add to the project group and click [Add]:

First Name AY Ml AT Last Name A ¥ User Name A ¥ IDAY Project Role
L | | \_ ) | us| |
Joe P Smith Jjoesmith Us000003 [ — select Role — V|

[» Filter |[» Clear Filter |[» Add |+ Cancel |

You now should narrow down the list of users by entering filter criteria and clicking [Filter]. Once you have
located the appropriate user(s), just select a group role for them from the drop-down list and click [Add] to
add them to the group in the specified role.

b) Group Project List

This tab allows you to see the list of projects that are contained within the current group. Clicking on the
name of the project will take you to the details page for that project:

User Membership Project List
Project Name Web Site Creation Date Active 1D
Library Information System ht aryinformationsystem.org = 1-Dec-2005 Yes PRO0O0OD1
e Application One puri.org = 1-Dec-2005 Yes PROD0ODO2

3.1.3. Project History

This page displays a list, by default in chronological order, of changes made to items within the selected
project.

At this time, only changes made to Requirements, Tasks, Incidents, Test Cases, Test Steps, Test Sets,
Releases, and Automation Hosts are recorded. Certain changes are to these artifacts are not recorded,
such as location changes (indenting, outdenting), and comment additions.
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Project History Changes | Library Information System (Change Project)

This page lists all the changes that were made in the selected project. To view the details and optionally restore or purge a specific changeset artifact, click the changeset ID
?&J)n:ebve;ﬁ multiple items at once, select the checkboxes and then click the "Revert” button_ If you select multiple changesets for a single artifact, changes will be rolled back to the
earliest changeset. You cannot roll back an Added, Purged, or Rollback changeset.

Displaying 1 - 15 out of 79 items. Refresh | Apply Filter | Clear Filter
v ChangelD AV Change Date AV Changed By 4 ¥ Artifact Type A¥ ArtifactID AY Artifact Name 4 ¥ Change Type AY
mE Il @) [- v - v O[] [ | flper- )
O |#19 28-Jan-2014 Fred Bloggs Incident ‘; Ability to integrate with other systems. Modified
O |#78 28-Jan-2014 Fred Bloggs Task 42 Write subject object update queries Modified
O |#7 28-Jan-2014 Fred Bloggs Task 4 Create subject object update method Modified
[ #i6 28-Jan-2014 Fred Bloggs Task 40 Develop edit subject details screen Modified
O |#i5 28-Jan-2014 Fred Bloggs Requirement 21 Ability to edit existing subjects in the system | Modified
[0 |#74 28-Jan-2014 Fred Bloggs Task 42 Write subject object update queries Modified
O |#13 28-Jan-2014 Fred Bloggs Task 41 Create subject object update method Modified
O |#i2 28-Jan-2014 Fred Bloggs Task 40 Develop edit subject details screen Modified
O |#11 28-Jan-2014 Fred Bloggs Requirement 21 Ability to edit existing subjects in the system | Modified
[0 #70 28-Jan-2014 Fred Bloggs Incident 13 Ability to integrate with other systems Modified
O |#69 28-Jan-2014 Fred Bloggs Requirement 25 Ability to import from legacy system x Modified
O #68 28-Jan-2014 Fred Bloggs Task 36 Create author-subject mapping queries Modified
[] #67 28-Jan-2014 Fred Bloggs Task 35 Create author-subject mapping delete Modified

method
O |#66 28-Jan-2014 Fred Bloggs Task 34 Create author-subject mapping insert method | Modified
O #65 28-Jan-2014 Fred Bloggs Task 33 Develop author-subject association screen Modified
Shuw| 15 v:‘ rows per page Displaying page |Z| BaofGmep
(+ Revert ) + Purge AL

There are a handful of change types recorded and displayed here:

Modified: The most common, this means that one or more fields in this artifact were changed.
Note that if a standard field and a custom field were changed at the same time, it will generate
two separate entries, one for the standard fields, one for the custom fields.

Added: This means that this artifact was added, created in the system, either by using the New
menu option or by copying. Pasting an item that was cut will not result in an Added entry being
created.

Rollback: This items means that the artifact was rolled back to a specific event in the history.
Deleted: This entry is created when an artifact is deleted from the system.

Undelete: This entry is created when an artifact was deleted and then undeleted, making it live in
the system again.

Purged: This entry is created (and all other history items are removed) when a deleted artifact is
purged from the system. Purged items are removed from the database, and cannot be recovered.

Note: When upgrading from a version before v3.1, each individual field changed will be considered a
unique change, due to how previous versions recorded history. However, as soon as the application is
upgraded, simultaneous changes will be grouped together based on their last-update date.

This screen allows the administrator several options:

3.1.4.1.

Viewing Details: The detail screen for each change set can be viewed by clicking on the change
ID #. This will take you to the history details screen, described below.

Revert: This button will roll back all items in the list that are checked. You must have at least one
row checked to revert. See the section on reverting below.

Purge All: This button will permanently purge all deleted items from the database. Once items are
purged, they cannot be restored.

History Details Screen

The history details screen displays information on the selected change set:
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<= Back to List View Item ] Revert

History Details | Library Information System (Change

The details for this changeset are listed below.

Change ID: &0 Change Date: 1/29/2014 12:48:54 PM
Changed By:  System Administrator Change Type: Modified
Artifact: Incident [IN:1 Field Set: Standard Fields

Artifact Name: Cannot log into the application

Change Actions

Field Name 4 ¥ Old Value A ¥ New Value 4 ¥
Priority 1 - Critical

Severity 3 - Medium

Status MNew Assigned

Type Incident Bug

Owner Fred Bloggs

Start Date 1/8/2014 5:00:00 AM
Est. Effort 300

Projected Effort 300

The History Details screen will show basic information as well as fields that were changed in this change
set. Shown here is the Change ID, the date and time that the change was made, the user that made the
change, the change type, the artifact affected, and the set of fields affected.

If a set of fields were affected (Standard or Custom), then the list of fields will be listed below. In the
example above, the change was a Madification, and 5 fields were changed. In other change types, no
fields will be displayed.

If the artifact is still available in the system, you can click the Artifact or click the ‘View Item’ button in the
toolbar to view the item as it is currently. However, if the item has been deleted, a warning label will be
displayed (as above in the example screenshot), the View Item links will be disabled, and a new option,
“Purge” will appear on the toolbar.

3.1.4.2 Purging Items

Items that have been deleted by any user still remain in the database, but do not affect statistics or
reports, and do not show up in reports and cannot be viewed. The artifacts are still in the database,
however, and can be restored by clicking on the Restore button in the toolbar.

Purging an individual item can only be done while viewing one of its history detail screens. Once an item
is purged, you will be taken back to the history list screen. All the previous history items for the artifact will
be removed, and replaced with a single “Purged” history item.

Items that are purged cannot be restored into the database, as unique identifiers will be wiped from the
database, so be sure that you are sure you want to purge an item before doing so.

You can purge all items in the project at once by clicking the “Purge All” button located on the History List
page. This will take some time depending on how many deleted items are in your database, and it is
recommended that the database files be compressed in SQL Management Studio afterwards to free up
space and compress clustered indexes.
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3.1.4.3 Reverting Items

Reverting an artifact will attempt to reset all fields back to the selected change set, reverting all changes
made after the selected change set as well. In certain cases, the artifact will not be able to be reverted —
cases like this could be caused by other items having been deleted or purged. (For example, if
Requirement #1 was linked to Release #4, and that Release does not exist anymore.) In cases like this,
no fields will be reverted and the artifact will remain unchanged.

Reverting an item will cause it to be undeleted if it has been deleted.

You can revert multiple items from the History List page — however, the only items that can be reverted
back are Deletes and Modifications. All other types will be ignored. When selecting multiple items, you
can select more than a single change set for a specific artifact, the artifact will be rolled back to the
earliest change set selected.

3.1.4. Project Data Tools

This page contains several different data management tools that can be used to identify certain data
issues in the system and correct them. There are two main sections to this page — Data Caching and
Indentation Hierarchy:

Data Tools | (Change Project)
In order to improve the performance of the application, certain types of data is cached. Sometimes after making changes to the underlying data, you might want to refresh the cached
information. To do that, click on one of the links below:
= Refresh the Tes
> Refresh the Task P

Sometimes corrupted indentation infermation can cause missing or duplicated rows in tables. If any of the flags below show 'Error’, you can click on the link to try to fix them:

= Requirements: OK {Correct
> Test Cases: OK (Correct)
> Test Sets: OK (Correct)

> Releases: OK (Correct

a) Data Caching

In order to improve the performance of SpiraTeam®, certain types of project data are cached. If for any
reason you make changes to test cases, test runs or tasks in the system through the database, you may
need to update the cached values for test execution status and task progress that are displayed on the
requirements and releases pages. To refresh the execution status or task progress data, click on the
appropriate “Refresh” link illustrated above.

b) Indentation Hierarchy

The Requirement and Test Case pages use an “Indent” system for managing the hierarchy of information.
This allows requirements and test cases to be nested under parent items and be rapidly searched and
filtered on. Sometimes if a move/copy operation is interrupted (due to a network outage, etc.) the
hierarchy may get corrupted. If so, you'll see a red Error message instead of the Green OK. If that
happens, just click on the appropriate “Correct...” hyperlink and the system will correct the indent levels
for you.
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3.2. Users

3.2.1. View / Edit Users

The following screen is displayed when you choose the “View/Edit Users” link from the Administration
sidebar navigation:

View / Edit Users (Import Users From an L DAP Server)

The following approved users exist in the system. To edit an existing user, please click on the 'Edit’ link next to hisiher name

To create a new user either click on the [Add] button or choose the option to Import from an LDAP server

To see any pending new user requests, click on the 'Pending Requests’ item in the left hand navigation.
First Name AY MI AY LastName 4V User Name 4 Admin 4 ¥ Email ? A¥  Department 4 ¥ User# AY  Active &Y Operations
| | ] SR N R | us[ | [zaw- V]
Amy E Cribbins amycribbins No No Software Engineering Us000013 No > Edit
Bernard P Tyler bernardtyler No No Software Engineering usoooot1 No > Edit
Donna w Harkness donnaharkness No Mo Software Engineering usooooone No > Edit
Fred Bloggs fredbloggs No No QA Us000002 Yes > Edit
Henry J Cooper henrycooper No No Software Engineering usooooiz No > Edit
Jack Van Stanten jackvanstanten No No Software Engineering usooooay No > Edit
Joe P Smith joesmith No Mo QA uso0oo03 Yes > Edit
Martha Noble marthanoble No Mo Software Engineering usoooo10 No > Edit
Ricky Pond rickypond No No Software Engineering Us000005 No > Edit
Roger Q Ramjet rogerramjet No No Software Engineering usooooo4 No > Edit
Rory Jones roryjones No No Software Engineering Us000009 No > Edit
Rose T Smith rosesmith No No Software Engineering usooooos No > Edit
System Administrator administrator Yes Yes usooooon Yes > Edit

(= Filter |(» Add | (> Clear Filter |

This screen displays the list of users in the system (both inactive and active) together with their first name,
middle initial, last name, username (login), administrative permission status and active status.

You can filter the list of users by either choosing an administrative / active status, or entering a portion of
the first name, middle initial, last name or username into the appropriate text box. When you click the
<Filter> button, the list of users will be filtered by the criteria you entered. You can clear the filter selection
by clicking the <Clear Filters> button. To sort the list of users, just click on the appropriate arrow icon
located in the header row of each field (one each for ascending / descending). In addition, the list of users
is paginated into groups of fifteen (15). You can step through the different pages by clicking the page
numbers at the bottom of the user list.

To add a new user to the system, simply click the <Add> button at the bottom of the user list, and a new
screen will be displayed that allows you to enter the new user information:
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Add/Edit User | New User

Please review the information listed below and make any changes if necessary.
Once you have finished, click [Update/insert] to confirm them.

First Name™:

Middle Initial:

User Name*

|
|
Last Name™: |
[
|

Depariment:

Email Address™: [ |

Email Enabled*: [ves ¥

System Administrator: (Ho V|

Active™: | Yes W |
Locked Out*: | Mo W |
RSS Token: 7| Enable RSS Feeds

[+ Generate New

Passwords & Security

New Password*: | |

Confirm Password™: | |

Passwords are required fo be a minimum of 6 characters in length.

Passwords are required fo have @ minimum of 0 nen-alphanumeric characters.

Password Question™ [ |

Password Answer*: | |

On this screen, you can enter the name, email address, password, password reset question and answer
for the new user. If you want the user to be able to subscribe to items in the system as RSS feeds, you
should also make sure that the “Enable RSS Feeds” checkbox is selected and a GUID token is displayed
in the text-box underneath.

Note: If you make a user a System Administrator, it will force that user to always have the ‘Project Owner’
role on all their assigned projects, regardless of the chosen role. If you disable this option, they will then
revert back to their true role.

In a similar way, to edit the details of an existing user, simply click the “Edit” hyperlink in the user list box,
and you will be taken to the following screen that allows you modify the user details:
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Add/Edit User | Fred Bloggs

Please review the information listed below and make any changes if necessary.
Once you have finished, click [Update/Insert] to confirm them.

First Name™: [Fred J
Middle Initial: [ )

Last Name*: |:B|oggs . ]
User Name™: [fredbloggs |

Department: [aa ]

Email Address™ [fredbloggs@spiratest.com |

Email Enabled*: [He ¥

System Administrator: [No V|

Active*: [Yes ¥|
Locked Out*: [He ¥
RS5 Token: ¥|Enable RSS Feeds
(» Update |~ Cancel

On this screen you can edit the first name, middle initial, last name, username, email address, system
administration status and active status. Once you have made the necessary changes, click the <Update>
button to commit them. If you decide that you want to ignore the changes, click the <Cancel> button and
the changes will be discarded.

In addition, there are four tabs that allow you to add/remove the user from projects, change the user’s
password information, update the data-mapping used when synchronizing artifacts that are assigned or
created by the current user, and specify whether the user can access the linked TaraVault™ source code
management service..

If you click on the “Project Membership” tab you will be shown a list of projects that the user is currently a
member of:

Project Membership Passwords & Security Data Mapping Taraault Membership
v Project Name Active Project # Project Role
O Library Information System Yes PRO0OO0OO1 | Manager v |
O Sample Application One Yes PRO0O0O0O0O2 | Developer v |
O Sample Application Two Yes PRODO0O0O3 |'Tester v |
(» update |(+ Add |+ Delete |

You can change the role that the user has on the various projects, by simply choosing the appropriate
role from the drop-down list and then clicking [Update]. To remove the user from a project, simply select
its checkbox and then click [Delete]. To add a user to a new project, simply click on the [Add] button and
then choose the project and associated role from the list of projects on the screen that is displayed:

Add User Project Membership | Henry J Cooper
=< Back To User Details

The user is NOT a member of the following projects
Please select a role for the projects you want to add this user to, then click [Add]:

Project Name Web Site Creation Date Active 1D Project Role
Legacy Application 1-Dec-2005 Yas PRO00DO0O4 |'__ Select Role — v'|

w.tempuri.org = 1-Dec-2005 Yes PRO0O0D0O0O2Z |'__ Select Role — v'|

Sample Application Cne

1-Dec-2005 Yes PRO00003 [~ Select Role — v
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Then click [Add] to add the selected project(s) to the user’s project membership.

To change the user’s password (if the user is managed by SpiraTeam) or LDAP information (if managed
by an external LDAP directory server), click on the “Passwords and Security” tab:

Project Membership Passwords & Security Data Mapping TaraVault Membership
[JLDAP Managed User
L

[Ichange Password

Passwords are required to be a minimum of & characters in length.

Passwords are required to have & minimum of D nen-alphanumenc characters.

[JChange Password Question & Answer
[Whatis 1+17 |

On this tab you can either update a user’'s password (and associated password reset question and
answer) or their LDAP Distinguished Name (DN). You can also use this screen to switch a user from
LDAP-Managed mode to SpiraTeam-Managed mode.

In LDAP-Managed mode you enter the fully Distinguished Name (DN) for that user in your corporate
LDAP server and provide no password. SpiraTeam® will then query your corporate LDAP server for the
password information, reducing the number of passwords that a user needs to remember. Please see the
sections on “Importing LDAP Users” and “LDAP Configuration” for more details.

To view/change the list of usernames that a user has in an external bug-tracking system, click on the
“Data Mapping” tab. This section is used by the SpiraTeam data-synchronization service to map incidents
from SpiraTeam to other bug-tracking systems

Project Membership Passwords & Security Data Mapping Tara\Vault Membership

BugzillaDataSync ID: [fredbloggs ]
FogBugzDataSync ID: |: :|
JiraDataSync ID: |:fred bloggs :|
MsTfsDataSync ID: |:Fred Bloggs :|
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Please see the SpiraTeam External Bug-Tracking Integration Guide for more details on using the data-
mapping tab.

If you click on the TaraVault membership tab, you will see the following information:

Project Membership Passwords & Security Data Mapping TaraVault Membership

Enable user for TaraVault? O

If you check the box, it will enable this user to access the linked TaraVault source code repository. This
service is only available for hosted/cloud instances of SpiraTeam, and more details can be found in
section 3.10.4 of this guide.
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3.2.1.1. Importing LDAP Users

If your organization already has an LDAP compatible user management system in place (e.g. Windows
Active Directory, Novell eDirectory, OpenLDAP, IBM Tivoli, etc.), then instead of having to manually enter
users one by one into SpiraTeam®, you can simply import them from your LDAP Server. Before doing
this however, you need to first setup the LDAP configuration (see the section on LDAP Configuration
below.

Once you have setup your LDAP server configuration in SpiraTeam®, clicking on the “Import Users From
and LDAP Server” will bring up the following screen:

Import Users from LDAP Server
<< Back To User List

Using the current LDAP configuration, the following new users are available for import into SpiraTeam.
Please mark the ones you'd like to import then click the [Import] button:

v Common Name AY Login AY First Name A¥ Middle Initial A¥ LastName AY Email Address A ¥ Distinguished Name

oo ] = ) I | I |
[] Elise M. Brooks elise brooks | Elise M Brooks CN=Elise M.
Brooks,CN=Users, DC=corp,DC=inflectra.DC=com
[  Enterprise Admins Enterprise CN=Enterprise
Admins Admins, CN=Users,DC=corp DC=inflectra.DC=com
[] Enterprise Read-only | Enterprise CN=Enterprize Read-only Domain
Domain Controllers Read-only Controllers,CN=Users, DC=corp, DC=inflactra,DC=com

Domain
Controllers

[» Filter | (» Clear Filter |(» Import | > Cancel |

This screen lists all the users available in the LDAP server that have not been already imported into
SpiraTeam®. The users are listed by name along with their login, email address and fully distinguished
LDAP name (DN). You can narrow down the list by entering partial name matches in any of the fields
displayed and clicking [Filter] and/or you can sort the results by clicking on the directional arrows in the
field headings.

Select the checkbox of any users you want to import and click <Import> to complete the operation. These
users can now login to SpiraTeam® and use their existing LDAP login and password information.

3.2.2. Project Membership

The following screen is displayed when you choose the “Project Membership” link from the Administration
sidebar navigation:

Project Membership | Sample Application One (Change Project)

The following users are members of this project. To change their role, just select the value in the dropdown and click Update.
To add a new user to the project, click [Add]. To remove existing users, select their checkboxes and click [Delete].

v Full Name User Name Project Role

[] | FredEBloggs fredbloggs ( Developer V|
[] |JoeP Smith joesmith [ Tester v|
] System Administrator administrator | Project Cwiner ¥ |

(» Update |[» Add ||+ Delete |

This screen displays the name of the current project together with a list of all the users who are currently
members of the project along with their currently assigned project role. If you want to modify the
membership for a different project, simply click the “Change Project” link to be taken back to View/Edit
Projects screen where you can select a different project.

To modify the role of a user assigned to the project, simply change the role for that user’s entry in the
drop-down menu and click the <Update> button. To remove a user from the project, simply check the box
to the left of the user’'s name and click the <Delete> button. Note that this only removes them from the
project, not the entire system.
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To add a user to the project, so that can access its information, simply click the <Add> button and you will

be taken to the following screen that lists all the users in the system that are not currently members of the
project:

Add Project Membership | Sample Application One (Change Project)
=< Back To Project Membership

The following users are NOT members of this project.
Please select a role for the users you want to add to the project and click [Add]:

First Name AY Ml AY Last Name 4V User Name 4'Y DAY Project Role

L) { | | ) L J us| |

Amy E Cribbins amycribbins Uso00013 | — Select Role — v|
Bernard P Tyler bernardtyler usoooo11 |: —- Select Role — ¥|
Donna W Harkness donnaharkness Us000006 |: —~- Select Role — v|

[+ Fitter |(» Clear Filter |[» Add |+ Cancel |

You now should narrow down the list of users by entering filter criteria and clicking [Filter]; you can also
sort the results to make viewing easier. Once you have located the appropriate user(s), just select a

project role for them from the drop-down list and click [Add] to add them to the project in the specified
role.

3.2.3. Active Sessions

Often an administrator of the system will want to know how many users are currently logged into the
system, especially on installations licensed by concurrent-user. Clicking on the ‘Active User Sessions’
administration option will display a list of all the users who currently have active sessions in the system:

Active User Sessions
You currently have 2 active user(s) in the system.
The following users currently have active sessions on this instance of SpiraTeam

First Name Last Name User Name Session ID

Interface Last Logon ID Operations
System Administrator administrator oslvtqgxk2k5gkjdnvvpiuhy Web Application 1/28/2014 11:03:19 AM us000001 End Session
Fred Bloggs fredbloggs bbz0tshb1t5xImmevrehnkaz Web Application 1/29/2014 11:04:32 PM us000002 End Session

To end a user's session, please click on the appropriate 'End Session’ link above.

Each user is displayed along with their user ID, whether they're connected through the application or via a
third-party add-on, and the date they last logged-in. The administrator is able to forcibly end a user’s
session using the ‘End Session’ link to the right of their name. Clicking this link will result in that user
being logged out when they try and perform an operation in the system. Warning: You should make
sure that the user is not actively using the system to prevent any unsaved data being lost.

3.2.4. Pending Requests

If you have enabled the ability for users to register for new SpiraTeam accounts themselves (see section

3.8.6 — Security Settings), clicking on the “Pending Requests” administration option allows you to view a
list of all the outstanding requests for new user accounts:

View Pending User Requests

The following new user requests exist in the system. To approve a user click the "Approve’ link, to deny a request click on the 'Delete’ link

First Name AY Ml AV Last Name 4 ¥ User Name 4 ¥ Email 7 4 ¥ User# 4 ¥ Active 4V Operations
| | | | | | | (- V] us| \ [Aw- ]
Roger Smith rsmith Yes Us000031 Yes > Approve | Delete

» Filter |[» Clear Filter

For each pending user request you can choose to either Approve or Deny the request:

>» Approve — clicking this option will approve the user. They will get an email letting them know that
they have been approved and can now log into the system.
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> Delete — clicking this option will delete the pending user request from the system.

3.2.5. View / Edit Roles
There are six (6) default project roles that a user may be assigned to a project with:

» Project Owner —the same rights as a Manager, but in addition can access the project
administration tools

» Manager — can see all screens and add/edit all artifacts, but cannot access project administration
tools

>» Developer — can see all screens, but can only add/edit incidents, tasks and tests and change
requirement coverage

» Tester — can see all screens, but can only add/edit incidents and execute tests. Note: cannot
delete incidents, only a Manager can do that.

>» Observer — can see all screens, but cannot perform any write operations (insert / update / delete)

Incident User — can only view and edit incidents. This user cannot even see the project’s
requirements, tasks, test cases or releases.

Note: The System Administrator is automatically added to every project as a Project Owner, and can
never be removed as Project Owner, made inactive or made a different role on the project.

You can make changes to the permissions associated with each of these default roles, and also create as
many additional roles as you like. To customize the roles in your installation of SpiraTeam®, simply click
on the “View / Edit Roles” link in the Administration sidebar navigation:

View / Edit Roles

Role Name Description Active 1D Operations
Project Owner | Can see all screens, create/modify all artifacts, and can access the preject administration tools Yes RX000001 | > Edit |
Manager Can see all screens and create/modify all artifacts, but cannot access project administration tools Yes RX000002 >
Developer Can see all screens, but can only create/medify incidents and tests and change requirement coverage Yes RX000003 =
Tester Can see all screens, but can only create/modify incidents and execute tests. Note: cannot delete existing incidents Yes RX0D00004 | >
Observer Can see all screens, but cannot perform any write operations (create / modify / delete) Yes RX000005 | =
Incident User Can only create/modify/view incidents. This role cannot see a project's requirements, test cases or releases Yes RXD00006 | >

(> Add Role

The screen lists all of the roles currently configured in the system (both active and inactive) together with
the name, description, and an active flag. You can create new roles by clicking the <Add> button which
will create a new default role entry in the list. You can edit the name, description and associated
permissions of a role by clicking on the appropriate “Edit” link. You can delete an existing role, by clicking
the “Delete” link. Note that you cannot delete any of the default roles, but can instead make them inactive.

Clicking on the edit link will take you to the following screen:
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Edit Role Details | Tester

Please review the information listed below and make any changes if necessary.
Once you have finished, click [Update] to confirm them.

Role Name*: | Tester

Description: (Can see all screens, but can only create/modify incidents and execute tests. *
Mote: cannot delete existing incidents

Project Admin*: (N0 ¥|
Speciﬂes whether this role has project adminisirative permissions
Limited View™: [no 7|

Speciﬂes whether this rale has limited view permissions. Use this for roles that should only let a user see their own
created/assigned items and nothing else in the project.

Active™: [ves 7|
Speciﬂes whether this role is active or not

On the top of the screen, you can edit the name, description, project admin, limited view and active flags:

>» Project Admin — this flag denotes whether this role has administration-level access to the project

(for example the project owner role has this set by default)

>» Limited View — this flag denotes that the role has a restricted view of the project, with the user
only allowed to see the artifacts that they have either created or been assigned

> Active — This flag denotes if the role is active in the system

Underneath you can specify the various artifact-specific permissions for the role:

Artifact Permissions
This role can perform the following operations on the various artifacts:
Artifact Type Create Modify All Delete View Modify Owned
Requirement i
Test Case v v
Incident 7 Pl v
Release v
Test Run v v
Task
Test Step i
Test Sat v v
Automation Host Fl v 7

These permission options allow you to specify if a user can create, modify, delete or view each of the
artifacts in the system. If a user does not have view permissions for the artifact, then the corresponding
tab in the system will also be disabled. There are two kinds of Modify permission available:

» Modify All — this option specifies that the user can modify all the artifacts of this type in the

project (e.g. the user can edit all test cases)

>» Modify Owned - this option specifies that the user can modify only the artifacts in the project that
were either created or assigned to this user (e.g. the user can edit only the requirements they

created or have been assigned)

Note: The permission needed to execute a test case is the “Create + Test Run” permission since that

initiates the creation of a new test run.
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In addition, there are some artifact-wide permissions that can be specified for each role:

Other Permissions

This role can perform the following operations throughout the system:

Artifact Type Add Edit Delete View
Document -
Document Folder - - -
Comment - - -
Source Code - -

(> Update |[» Cancel |

This section lets you specify if the role allows users to add new documents to the project, edit existing
documents, delete documents, edit the document folders, and view/edit source code revisions.




3.3. Custom Properties

SpiraTeam allows you to customize all of the artifacts in the system (requirements, test cases, incidents,
etc.) by adding user-defined custom properties in addition to the built-in fields. You can create a variety of
different types of custom properties. This section describes how you setup different custom lists and
custom properties in your projects.

Artifacts in SpiraTeam can have up to 30 different custom properties per artifact-type, per project. There
are different types of custom properties allowed:

Text: Normal or Rich-Text field.

Integer: Whole-Number entry.

Decimal: Fractional number entry (currency, etc.)
Boolean: Simple yes/no (on/off) checkbox.

Date: Date selector.

List: Custom List selector.

Multi-List: Custom List selector that allows multiple values.

User: List of assignable users.

Each custom property can have optional settings applied to it. Optional settings are as follows. (Note that
not all settings are allowed for all property types.)

Default: The default value when a new artifact is created.

Allow Empty: Whether or not an empty value is allowed.

Precision: (Decimal Only) How many decimal places is allowed (or the value is rounded to).
Minimum Value: The minimum value allowed.

Maximum Value: The maximum value allowed.

Minimum Length: The minimum length of the data required in the field.

Maximum Length: The maximum length of the data allowed in the field.

Rich Text: Whether or not the text field allows HTML or not.

Custom List: The defined Custom List for the field that users can select from.

Important: Note that setting ‘Allow Empty’ to No will override any workflow step definitions, and will
always require a value to be entered in, even if the workflow is configured to have the field disabled!
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3.3.1. Edit Custom Lists

If you are planning on having any list based custom properties in your project, then you first need to
create and populate the custom project lists that the user will be able to select from. These lists are stored
separately from the individual artifact types so that you can have one set of values (e.g. list of operating
systems under test) be reused by multiple artifact types.

The following screen is displayed when you choose the “Edit Custom Lists” link from the Administration
sidebar navigation:

Edit Custom Lists | Library Information System (Change Project)

The following custom lists have been created in this project. To add a new custom list, please click on the "Add List” option, to
remove a custom list click the appropriate "Remove” button and to edit a custom list (including its values), click on the "Edit
WValues” button.

List # List Name # Values Actions

[CL:000001] Difficulty 3 Edit Values | Remove
[CL:000002] Requirement Type 2 Edit Values | Remove
[CL:000003] Test Type 3 Edit Values | Remove
[CL:000004] Operating System 7 Edit Values | Remove
[CL:000005] Web Browser 4 Edit Values | Remove
[CL:000008] Step Type 2 Edit Values | Remove

= Add List

The screen displays all the custom lists currently defined within the project, together the number of values
associated with each list. By default the screen will initially be empty so the first thing you need to do is
click <Add List> to create a new custom list:

=< Back to Custom Lists

Edit Custom List Values | New List

List Name: [New List
Selector Display Sorting: |'A|phabeﬁua| v |
By ID
The following custom values | sphabetical list. Please make any changes and click [Save].
To remove an existing custo move' link.

To add a new value, click the "Add Value' link at the bottom of the grid.

Display: Al Active v|
List Value # Value Active Status Actions
No list values defined. Add Value
> Add Value

After changing the name of the list, and specifying whether the values will be ordered by their name or the
order in which they were entered (called by ID), you can either click <Save> to commit the change, or
click the <Add Value> option to add some list values:
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=< Back to Custom Lists

Edit Custom List Values | Database Platforms

List Mame: |:Database Platforms

Selector Display Serting: | Alphabetical v |

The following custom values have been created for this list. Please make any changes and click [Save].
To remove an existing custom list value just click the 'Remove’ link.
To add a new value, click the "Add Value' link at the bottom of the grid.

Display: | Al active v
List Value # Value Active  Status Actions
[Pv:000023] [M\,r sal | | Yes v| Active > Delete
[Pv:000024) |:Orac|e | | Yes v'| Active > Delete
[Pv:000022) [SQL Server | |: Yes v:| Active > Delete
= Add Value
[+ save |+ cancel

This is the set of values that the user will select from the drop-down list when the custom property is
displayed. You can change the display to include:

e All Active — displays only custom list values that are active

e All But Deleted — displays all custom list values that are active or inactive but have not been
deleted

e All —displays all custom list values, including those that have been deleted

To add a new custom list value, click the <Add Value> button and a new row will be added to the list
which you can now edit. To edit an existing custom list value, simply change the name in the textbox and
click <Save>. To delete a custom list value, simply click on the “Delete” hyperlink. If you want to remove
an item from the list temporarily, you can set its Active dropdown list to ‘No’, if you want to remove an item
permanently, just click the ‘Delete’ button.

Note: Even if you delete a custom list value, there is an option to undelete by simply changing the display
selection to “All” and clicking the ‘Undelete’ hyperlink next to a deleted value.

To edit an existing custom list, you just need to click on the “Edit Values” hyperlink to display the custom

list name and list of associated values (which is the same screen as the one displayed for a new list). To

remove a custom list from the project, just click on the “Remove” hyperlink next to the custom list and the
list and all its associated values will be deleted from the project.
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3.3.2. Edit Custom Properties

This option is used to actually define the custom properties associated with each artifact type in the
project. The following screen is displayed when you choose the “Edit Custom Properties” link from the
Administration sidebar navigation:

Edit Custom Properties | Library Information System [Chanage Project)

The following custom properties are currently defined for the selected artifact type. To view the custom properties for a different ar

below.

You can add, edit or remote custom property definitions by clicking the appropriate link in the grid below:

Artifact Type: | Requirement "'|

Field # Property Name Type Legacy Name Actions
1 URL Text TEXT_M > Edit Definition | Remove
2 Difficulty List LIST_01 > Edit Definition | Remove
3 Requirement Type List LIST_02 > Edit Definition | Remove
4 MNotes Text TEXT_02 > Edit Definition | Remove
5 Review Date Date > Edit Definition | Remove
G Decimal Decimal > Edit Definition | Remove
7 = Add Definition
3 > Add Definition

The screen displays a list of all the possible custom properties for a particular artifact type for the current
project. Each artifact type (requirement, test case, etc.) can have up to thirty (30) custom properties of
various types.

Initially the screen will default to showing the existing custom properties for a project's Requirements; to
change the list to a different artifact type (e.g. Incidents), all you need to do is change the artifact type in
the drop-down-list. This will refresh the list to show the custom properties for that artifact type.

To edit an existing custom property definition or add a new definition, click the “Edit Definition” link for a
specific property, and the following dialog will be displayed:

Definition Cptions

Name: [Requirement Type
Type: Ut W)

Custom List: | Requirement Type

The fields visible will vary depending on the type of custom property you have selected, but every custom
property will need to have a Name and a Type. The Name is the caption that will be shown to the user
when viewing or editing the artifact. The type is the type of data the field allows. If the custom property is
either a List or Multi-List type, you will need to choose the associated Custom List that you previously
defined.

Under the Options tab will be available options that can be set for the custom property:
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Definition Options

Default: | Business Feature

Allow Empty. [ ves V|

When finished, click the ‘Save’ button and you will be returned to the Custom Property list.

Important: When changing a custom property’s type or removing a custom property, the data is not
actually removed from the artifact. Therefore, if you change a custom property from a date type to a text
custom property, the field will display the old date value until it is changed by the user.

3.4. Incidents

In addition to being able to create custom properties and values for incidents (same as for all artifacts in
SpiraTeam®), you can also change the values populated in many of the standard fields used in the
incident tracker — types, statuses, priorities and severities. The process for changing each of these is
described below:

3.4.1. Edit Types

The following screen is displayed when you choose the “Edit Types” link from the Incidents section of the
administration sidebar:

Edit Incident Types | Library Information System (Change Project)

Type # Display Name Associated Workflow Issue Risk Default Active
IT000001  incident | (Dot wonciow V) | 0 e [ves ¥)
IT000002 | [Bug | [Defautt Werkiow V| ] o |Ves:v'\
IT000003 | [Enhancement ] (omnvionw _ ¥] |0 O © (w7
ITO00004 | [issue | [Defautt Werkiow V| o i |Ves:v'\
IT000005 | (Training | [Detauwonciow V) [ [l |m:v:\
ITO0000 | [Limitation | [Defautt Werkiow V| ] o [ves ¥)
IT000007 | [Change Request | [Deautt wioriiow ¥ [l [l |v35:v:\
ITO00008 | [Risk | [Defautt Werkiow V| ] i |Ves:v'\

The screen displays a list of all the defined incident types for the current project. By default the screen will
be populated with the standard SpiraTeam® incident types. To edit an existing incident type, simply
change the name, associated workflow, issue check-box, risk check-box, set a default type and/or change
the active flag then click <Update>.

You can't delete an existing incident type, but to prevent it appearing in any drop-down-lists, all you need
to do is change its active flag to “No” and click <Update>. To add a new incident type, click the <Add>
button and a new row will be added to the list which you can now edit.

The associated workflow drop-down list allows you to specify which workflow the incident type will follow.
This is a very powerful feature since it allows you to configure different workflows for different incident
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types; i.e. a bug may follow a workflow geared to identification and resolution, whereas a risk may only
need a much simpler set of steps and actions.

The issue and risk check-boxes allow you to specify if the incident type is an issue or risk-type, which
means it is would be eligible for display in the issue or risk section of the project home page respectively.
The default radio button allows you to specify which incident type should be the default for newly created
incidents. This is the type that a new incident will be set to unless changed by the creator of the incident.
Note that you must have at least one active incident type, and you cannot set an inactive type as the
default.

3.4.2. Edit Statuses

The following screen is displayed when you choose the “Edit Statuses” link from the Incidents section of
the administration sidebar:

Edit Incident Statuses | Library Information System (Chanaoe Project)

Status # Display Name Open Default Active

15000001 (New | 7 ® [ves 7|
15000002 |SOper1 | 7 |Yes:"|
15000003 [Assigned | i |Yes:"|
13000004 [Resolved :| [Yes:"]
15000005 [Cbsed | |Yes:"|
15000008 [Not Reproducible | |E|
15000007 [Duplicate | [ves ]
15000008 [Reopen | 7 [Yes v]

[» Update [ﬂ]

The screen displays a list of all the defined incident statuses for the current project. By default the screen
will be populated with the standard SpiraTeam® incident statuses. To edit an existing incident status,
simply change the name, open check-box, set it as the default status and/or change the active flag then
click <Update>.

You can't delete an existing incident status, but to prevent it appearing in any drop-down-lists, all you
need to do is change its active flag to “No” and click <Update>. To add a new incident status, click the
<Add> button and a new row will be added to the list which you can now edit.

The open check-box allow you to specify if the incident status should be considered open or not, which
means it is would be eligible for display in the various sections of the user's home page and the project
home page that list open incidents. The default radio button allows you to specify which incident status
should be the default for newly created incidents. This is the status that a new incident will be set to when
first created, and acts as the first step in the incident workflow. Note that you must have at least one
active incident status, and you cannot set an inactive status as the default.

3.4.3. Edit Priorities

The following screen is displayed when you choose the “Edit Priorities” link from the Incidents section of
the administration sidebar:
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Edit Incident Priorities | Library Information System (Change Project)

Priority #  Display Name Calor Active
IP00000T (1 - Critical :| #7457 | [ves 7]
IPO0OODOZ |2 - High | # |m| l:l | Yes W |
IP00OO0O3 |3 _ Medium | # |W| l:l | Yes W |
IPOD0004 (4 - Low | & |'W'|I:| [ves V]

The screen displays a list of all the defined incident priorities for the current project. By default the screen
will be populated with the standard SpiraTeam® incident priorities. To edit an existing incident priority,
simply change the name, color and/or change the active flag then click <Update>. Note that you can
either enter the hexadecimal RRGGBB code for the color or use the pop-up color picker.

You can't delete an existing incident priority, but to prevent it appearing in any drop-down-lists, all you
need to do is change its active flag to “No” and click <Update>. To add a new incident priority, click the
<Add> button and a new row will be added to the list which you can now edit.

3.4.4. Edit Severities

The following screen is displayed when you choose the “Edit Severities” link from the Incidents section of
the administration sidebar:

Edit Incident Severities | Library Information System (Change Project)
Severity # Display Name Color Active
IV000DOT | 1 - Critica | a7 | [ves 7]
V000002 | (2 - High J 429056 | [E]
V000003 | (3 - Medium | #(BassT ] (Yes 7]
V00004 4~ Low Y [ R

The screen displays a list of all the defined incident severities for the current project. By default the
screen will be populated with the standard SpiraTeam® incident severities. To edit an existing incident
severity, simply change the name, color and/or change the active flag then click <Update>. Note that you
can either enter the hexadecimal RRGGBB code for the color or use the pop-up color picker.

You can't delete an existing incident severity, but to prevent it appearing in any drop-down-lists, all you
need to do is change its active flag to “No” and click <Update>. To add a new incident severity, click the
<Add> button and a new row will be added to the list which you can now edit.

3.4.5. Incident Workflows

Clicking on the “Edit Workflows” link in the Administration sidebar navigation brings up the list of defined
incident workflows for the current project. A workflow is a predefined sequence of incident statuses linked
together by “workflow transitions” to enable a newly created incident to be reviewed, prioritized, assigned,
resolved and closed, as well as to handle exception cases such as the case of a duplicate or non-
reproducible incident. The workflow list screen for a sample project is illustrated below:
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Edit Workflows | Library Information System (Change Project)

There are the various workflows available in the project. To add a new workflow, click the Add button, to edit an existing workflow, click
on the Steps hyperlink.

Workflow Name Default MNotify  Active Workflow# Operations
[Default Workflow | C ] [ves || WKOD0001 | Steps|Copy | Delete
(Copy of Default Workflow | v (Yes W] WKOD0005  Steps | Copy | Delete

(» cancel |[» save ][+ Add Workflow |

To modify the name, default status, notify and/or active flags, simply change the values in the appropriate
text-box, radio-button, check-box or drop-down list and click the <Update> button. To add a new
workflow, simply click the <Add> button and a new workflow will be created with the standard
SpiraTeam® steps and transitions.

You can have as many workflows as you like in a project, but only one can be marked as the default.
Each incident type is assigned to a workflow; this allows you to have different incident types follow
different paths from creation of closure. However when a new incident type is created, it will be initially
associated with the project’s default workflow. The steps and transitions that make up the default
workflow are illustrated in the diagram below:

[:] Open Status

Closed Status -
C] Duplicate Reopen

{ New 4>[ Open - Assigned - Resolved 4{ Closed

L Tt

Not Reproducible Recpen

L

The notify flag is used to tell SpiraTeam® whether that particular workflow should have email notifications
turned on or off. You define what transitions and which recipients should receive the emails in the
workflow transition editor (see below), but you can globally turn on/off notifications here as well. This is
useful if you find that the notifications are becoming an annoyance, or if the email server is unavailable for
a period of time.

Note: You can only assign an active workflow to an incident type, and similarly you cannot make a
workflow inactive that is currently linked to an incident type. This is important as all incident types need to
be linked to an active workflow at all times.
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3.4.5.1. Edit Workflow Details

Clicking on the <Steps> button of a workflow brings up the following screen that lists all the workflow
steps and workflow transitions that comprise the workflow:

View/Edit Workflow Steps | Default Workflow (Change Project)
=< Back to Workflow List
This displays all the incident status steps for this particular workflow
Step Name Transitions Status # Operations
Assigned 15000003 > Add Transition
Closed 15000005 > Add Transition
Duplicate eopen Incident (Delete) 15000007 > Add Transition
=> Reopen
New (Default) Assign Incident (Delete) 1S000001 > Add Transition
>> Assigned
Review Incident (Delete)
>> Open
Not Reproducible Reopen Incident (Delete) 15000006 > Add Transition
>> Reopen
Open 15000002 > Add Transition
Reopen 15000008 > Add Transition
Duplicate Incident (Delete)
>> Duplicate
>> No eproducible
Resolved Close Incident (Delete) 15000004 > Add Transition
=> Closed
Reopen Incident (Delete)
>> Reopen

This page lists in the left-most column all the various incident statuses defined for the project. The next
column lists all the possible transitions that can occur from that status. In addition, with each transition is
listed the name of the resulting destination status that the transition leads to. E.g. from the assigned
status, depending on your role (see later) you can move the incident to either duplicate, resolves or not-
reproducible depending on which transition the user takes.

Clicking on the name of a step or transition takes you to the appropriate details page (see below) where
you can set the properties of the step or transition respectively. To delete an existing transition, simply
click the <Delete> button after the transition name, and to add a new transition, click the <Add Transition>
button in the Operations column.

3.4.5.2. Edit Workflow Transition

When you click on the transition name link from the previous screen, you are taken to the workflow
transition details screen:
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Edit Workflow Transition | Resolve Incident (WT5)
<< Back to Workflow Steps List

=

Assigned (1S3) ‘ = ‘ Resolve Incident (WT5)

Resolved (154)

Workflow Transition Details

. I H ]
Name*: |Resolve Incident |

Notification Subject: |

(Display Email Subject Special Tokens)

» Update

The top part of the screen is the “workflow browser” which illustrates how the transition relates to the
workflow as a whole. It displays the current transition in the middle, with the originating and destination
steps listed to either side. Clicking on either incident status name will take you to the appropriate workflow
step details page. This allows you to click through the whole workflow from start to finish without having to

return to the workflow details page.

This part of the screen lets you change the name of the transition and specify the subject line of any email
notifications sent as part of this transition. To view the list of special tokens that can be used in the email
subject, click on the “Display Email Subject Special Tokens” hyperlink:

s nY
|| The following are all available tokens for Incidents and their meanings. Tokens not in this
, list will be taken out of the final message. Click on a token to insert it into the current cursor
| position in the editor above.
${ActualEffort} The actual effort, in ${Build} The build that the incident
HH:MM was fixed in
|| | ${ClosedDate} The artifact closed date.  ${CompletionPercent} | The percent complete
<
- ${Description} The description of the §{DetectedRelease} | The detected release
- artifact. name.
L | ${EstimatedEfforf]  The estimated effort, in | 3{ID#) The ID# of the item
H HH:MM
] | ${IncidentType} The Incident type ${Name} The name of the artifact
${NotifyTo} The notification ${Opener} The name of the Opener.
receiver's name.
| | ${Owner} The name of the ${Priority} The artifact's Priority
Owner
${Product} The name of the ${ProjectName} The name of the project.
] application.
${RemainingEfforf} | The remaining incident | ${Resolution} Currently not used
effort
bl | ${ResolvedRelease} The resolved release ${Severity} The artifact's Severity.
name.
${StartDate} The start date of the ${URL} URL to link to artifact
artifact.
${VerifiedRelease}  The verified release
name.
L . J

Each transition has a series of conditions which need to be satisfied for a user to actually execute the
transition (i.e. move the incident from the originating status to the destination status):

Conditions
The following users / roles are allowed to execute this transition
Condition Type Condition Data

[Ho ¥

The detector of this Incident can execute:

The owner of this Incident can execute: [ves ¥|

Users with the specified roles can execute: Project Owner
Manager:
Developer:
Tester:
Observer:

Incident User:
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Each transition also has a set of natification rules that allow you to specify who should get an email

notification if the transition is executed.

Notifications

Notification Type
The detector of this Incident is notified

The owner of this Incident is notified:

Users with the specified roles are notified:

The following users / roles are notified by email when this transition is executed:

Notification Data

Project Owner:
Manager
Developer:
Tester:
Observer:

Incident User:

» Update

Both the conditions and notifications allow you to set three types of user role:

» The detector of the incident can be allowed to execute the transition, and/or be notified when the
transition occurs. For example, when an incident is marked as Resolved, the detector should be
the only one who's allowed to move it to Closed. Similarly when an incident is moved from
Assigned to Resolved, the detector should probably be notified so that he knows to log in and
verify that it has been resolved satisfactorily.

The owner of the incident can be allowed to execute the transition, and/or be notified when the

transition occurs. For example, when an incident is marked as Assigned, the assigned owner
should be the only one who's allowed to move it to Resolved. Similarly when an incident is moved
from Open to Assigned, the owner should probably be notified so that he knows to log in and

begin resolving the incident.

A user with a specified role can be allowed to execute the transition, and/or be notified when the

transition occurs regardless of whether they are the detector or owner. For example a user with
role “Manager” might want the power to close all incidents regardless of ownership status, and
might also want to be notified when any incident is marked as Not-Reproducible.

You can set any of these conditions by changing the drop-down list and/or check-boxes and clicking

the appropriate <Update> button.

3.4.5.3. Edit Workflow Step

When you click on the incident status name link from either of the previous screens, you are taken to the

workflow step details screen:

Edit Workflow Step Details | Assigned

<< Back to Workflow Steps List

‘ Assign Incident (W =

=

Duplicate Incident (WT7)

‘ Assign Incident (W ‘ Assigned (153)

> | Resolve Incident (WT5)

=
=

T2 ‘
[T3) ‘

‘ Assign Incident (WT13)

> | Unable to Reproduce (WT

B)

The top part of the screen is the “workflow browser” which illustrates how the step relates to the workflow
as a whole. It displays the current incident status in the middle, with the possible originating and
destination transitions listed to either side. Clicking on either workflow transition name will take you to the
appropriate workflow transition details page. This allows you to click through the whole workflow from
start to finish without having to return to the workflow details page.
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This page allows you to define the behavior of the various incident fields (i.e. those that are a standard
part of SpiraTeam® such as Priority):

Incident Fields

The following Incident fields are hidden/disabledirequired at this step in the workflow:

Field Name Hidden Disabled Required
Actual Effort v

Fixed Build

Closed On

Description Fi

Detected Release
Est. Effort

Type

Name

Detected By
Owned By
Priority

<SS S S S

Remaining Effort Fi

Comments

Resolved Release

Severity

Started On i

Verified Release

» Update

This page also allows you to define the behavior of the various incident custom properties for this
particular step in the workflow:

Incident Custom Properties
The following Incident custom properties are hidden/disabled/required at this step in the workflow:
Name Type Hidden Disabled Required
Motes Text
Operating System MuliList
Web Browser MultiList
Internal? Boolean
Rank Integer
Review Date Date
Difficulty List
Reviewer User
Decimal Decimal
( Update _

You can set each of the fields/custom properties as being:
>» Hidden — The field / custom property will not be displayed when the incident is in this status
>» Disabled — The field / custom property will be displayed, but will be greyed-out and read-only
» Required — The field / custom property will be required when the incident is in this status

Note that you cannot set a field/property as being required and either disabled or hidden since this would
prevent a user from ever updating the incident. For example, when an incident is in the New status, you
might make the owner field hidden (since a detector shouldn’t need to know who will ultimately own it),
when it gets to the Open status, you might make the field active, and when it gets to the Assigned status,
you might make it active and required. This allows you to tailor the information gathered to the
appropriate place in the workflow.

To actually make these changes, all you need to do is select the appropriate checkboxes in the list of
fields and custom properties and click the corresponding <Update> button.
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3.5. Requirements

This section contains administrative options that are specific to the requirements functionality in the
system.

3.5.1. Edit Components

SpiraTeam lets you define a list of Components for each project. These components represent the main
functional areas of the system and requirements can be associated with each of the defined components.

Edit Components | Library Information System [Change Project)

The following components have been defined in this project. Please make any changes and click Save to commit:

Display: [an active v|
1D Name Active  Status Operations
4 [CP:3] |:Administration | | Yes "| Active | > Delete
# [CP:2] [Author Management ] | Ves ‘F| Active | > Delete
4 [CP:A] |:E!o{nk Management | | Yes "| Active | > Delete

> Add Component

[» Save |[» Cancel |

This page lets you display the list of components based on three predefined filters:

e All Active — This displays only the components that are listed as Active = Yes. Only active
components will be displayed inside the main application.

e All But Deleted — This displays all the components (active and inactive) except those that have
been deleted.

e All —This displays all the components (active, inactive, and deleted).

From this page you can click on the ‘Add Component’ option to add a new component in the list:

Edit Components | Library Information System (Change Project)

The following components have been defined in this project. Please make any changes and click Save to commit:

Display: [l v|

1D Name Active  Status Operations
# [CP3] |:Administration |
# [CP2]  |Author Management | |[Yes W] Active > Delete
-|
|

|"re5 v'| Active | > Delete

4 [CP:A] |:BoakManagement |:Yes v| Active | > Delete

4 | [CP:-1] | [‘[‘es v| Active
> Add Component
- Gance

After entering the name of the new component and choosing its Active status, click on ‘Save’ to commit
the new item. To edit an existing component, simply edit its name and Active status and click ‘Save’.
Finally to delete a component, simply click the ‘Delete’ option next to its name. Once deleted, an item can
be undeleted by changing the display to ‘All’ and then clicking ‘Undelete’:
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Edit Components | Library Information System (Change Project)
[ Successfully saved components
The following components have been defined in this project. Please make any changes and click Save to commit:
Display: [ai v|
1D Name Active  Status Operations
4 |[CP:3] [Administration | [‘r‘es Y| Active | > Delete
# [CP:2] |:Auth0r Management | |:‘r‘es Y| Active | > Deleie
& [CP1] [Book Management | [ves ¥]|Active | >Delete
[CP:4] | [New ltem ‘es Deleted | =
> Add Component

3.5.2. Requirement Workflows

Clicking on the “Edit Workflows” link under the Requirements heading, brings up the list of defined
requirement workflows for the current project. A workflow is a predefined sequence of requirement
statuses linked together by “workflow transitions” to enable a newly created requirement to be reviewed,
prioritized, assigned, developed and tested, as well as to handle exception cases such as the case of a
rejected or obsolete requirement. The workflow list screen for the sample project is illustrated below:

Edit Workflows | Library Information System (Change Project)

The following requirement types exist in the system. You can specify for this project, which workflows will be used for each requirement type:

Name Workflow 1D

=] | Feature | Default Waorkflow v | 0ooo02
=] | Need | Default Waorkflow v | 000001
=] Quality ( Default Warkfiow v 000005
& | Use Case [ Default Workflow v| 000003
=] | User Story [ Default Workflow v| noooo4

There are the various reguirement workflows available in the project. To add a new workflow, click the Add Workflow link, to edit an
existing workflow, click on the Steps hyperlink:

Workflow Name Default Active  Workflow # Operations
[Default Workflow | ® [ves | WKODODDO1 > Steps | Copy | Delete
> Add Workflow

The screen displays a list of all the standard requirement types in the system. The associated workflow
drop-down list allows you to specify which workflow the requirement type will follow. This is a very
powerful feature since it allows you to configure different workflows for different requirement types; i.e. a
User Story may follow a simpler review process than a Feature or Use Case requirement.

You can have as many workflows as you like in a project, but only one can be marked as the default.
Each requirement type must be assigned to a workflow. To modify the name, default flag, and/or active
flag of an existing workflow, simply change the values in the appropriate text-box, radio-button, or drop-
down list and click the <Save> button. To add a new workflow, simply click the ‘Add Workflow’ link and a
new workflow will be created with the standard SpiraTeam® steps and transitions.
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Note: You can only assign an active workflow to a requirement type, and similarly you cannot make a
workflow inactive that is currently linked to a requirement type. This is important as all requirement types
need to be linked to an active workflow at all times.

3.5.2.1. Edit Workflow Details

Clicking on the ‘Steps’ hyperlink of a workflow brings up the following screen that lists all the workflow
steps and workflow transitions that comprise the workflow:

View/Edit Workflow Steps | Default Workflow (Change Project)
<< Back to Workflow List

This displays all the requirement status steps for this particular workflow

Step Name Transitions Status # Operations
Requested (Default) Accept Reguirement {Delste) 000001 > Add Transition
>> Accepted

Review Requirement (Delete)
>> Under Review

Under Review Accept Requirement (Delete) 0oooo7 > Add Transition
>> Accepted

Reject Requirement (Delete)

>> Rejected

Rejected Return to Review (Delete) 0ooooe > Add Transition
>> Under Review

Accepted Assign Release (Delete) 000005 > Add Transition
>> Planned

Return to Review (Delete)
>> Under Review

Planned Remove from Plan (Delete) 000002 > Add Transition
>> Accepted
Start Development (Delete)

{Delete)
>> |n Progress

In Progress Cancel Development (Delete) 000003 > Add Transition

>> Planned

Einish Developmen
»» Developed
Mark as Completed (Delete)
>> Completed

t (Delete)

This page lists in the left-most column all the various requirement statuses defined in the system. The
next column lists all the possible transitions that can occur from that status. In addition, with each
transition is listed the name of the resulting destination status that the transition leads to. E.g. from the
Requested status, depending on your role (see later) the user can move the requirement to either
Accepted or Under Review, depending on which transition the user takes.

Clicking on the name of a step or transition takes you to the appropriate details page (see below) where
you can set the properties of the step or transition respectively. To delete an existing transition, simply
click the ‘Delete’ hyperlink after the transition name, and to add a new transition, click the ‘Add Transition’
hyperlink in the Operations column.

3.5.2.2. Edit Workflow Transition

When you click on the transition name link from the previous screen, you are taken to the workflow
transition details screen:

Edit Workflow Transition | Accept Requirement (WT2)
<< Back to Workflow Steps List

Requested (1) ‘ > |Accept Requirement (WT2) ‘ = ‘ Accepted (5)

Workflow Transition Details

Name™: |:Acc:ept Requirement
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The top part of the screen is the “workflow browser” which illustrates how the transition relates to the
workflow as a whole. It displays the current transition in the middle, with the originating and destination
steps listed to either side. Clicking on either requirement status name will take you to the appropriate
workflow step details page. This allows you to click through the whole workflow from start to finish without
having to return to the workflow details page.

This part of the screen lets you change the name of the transition In addition, each transition has a series
of conditions which need to be satisfied for a user to actually execute the transition (i.e. move the
requirement from the originating status to the destination status):

Conditions
The following users / roles are allowed to execute this transition
Condition Type Condition Data
The author of this requirement can exacute: |ﬁ|
The owner of this requirement can execute: |ﬁ|
Users with the specified roles can execute: Wem Cwner: i
Manager: )
Developer: O
Tester: O
Observer: O
Incident User: O

The conditions section allows you to set three types of user role:

» The author of the requirement can be allowed to execute the transition. For example, when a
requirement is marked as Completed, the author might be allowed to move it to Obsolete when
it's no longer applicable.

» The owner of the requirement can be allowed to execute the transition. For example, when a
requirement is marked as Under Review, the assigned owner should be the only one who's
allowed to move it to Accepted.

> A user with a specified role can be allowed to execute the transition regardless of whether they
are the author or owner. For example a user with role “Manager” might want the power to close
all requirements regardless of ownership status.

You can set any of these conditions by changing the drop-down list and/or check-boxes and clicking
the appropriate <Save> button.

3.5.2.3. Edit Workflow Step

When you click on the requirement status name link from either of the previous screens, you are taken to
the workflow step details screen:

Edit Workflow Step Details | Developed

<< Back to Workflow Steps List

| Continue Testing (WT63) | = > ‘ Continue Development (WT60) |

Continue Testing (WT64) > | Developed (4) | = | Mark as Completed (WT11)

| Finish Development (WT38) | = = ‘ Mark as Tested (WT10) |

The top part of the screen is the “workflow browser” which illustrates how the step relates to the workflow
as a whole. It displays the current requirement status in the middle, with the possible originating and
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destination transitions listed to either side. Clicking on either workflow transition name will take you to the
appropriate workflow transition details page. This allows you to click through the whole workflow from
start to finish without having to return to the workflow details page.

This page allows you to define the behavior of the various requirement fields (i.e. those that are a
standard part of SpiraTeam® such as Importance):

Requirement Fields

The following requirement fields are hidden/disabled/required at this step in the workflow:
Field Name Hidden Disabled Required
Author O O O
Comments O O [l
Component O O O
Description O O [l
Estimate O O
Importance O O
Requirement Name O O [l
Owner O O O
Release O O
Type O O O

(» Update

This page also allows you to define the behavior of the various requirement custom properties for this
particular step in the workflow:

Requirement Custom Properties
The following requirement custom properties are hidden/disabled/required at this step in the workflow:
Name Type Hidden Disabled Required
URL Text ] O O
Difficulty List O O O
Classification List ] O O
Notes Text ] O O
Review Date Date O O O
(~ Update

You can set each of the fields/custom properties as being:
>» Hidden — The field / custom property will not be displayed when the requirement is in this status
» Disabled — The field / custom property will be displayed, but will be greyed-out and read-only
» Required — The field / custom property will be required when the requirement is in this status

Note that you cannot set a field/property as being required and either disabled or hidden since this would
prevent a user from ever updating the requirement. For example, when a requirement is in the Requested
status, you might make the owner field hidden (since the author shouldn’t need to know who will
ultimately own it), when it gets to the Accepted status, you might make the field enabled, and when it gets
to the In Progress status, you might make it enabled and required. This allows you to tailor the
information gathered to the appropriate place in the workflow.

To actually make these changes, all you need to do is select the appropriate checkboxes in the list of
fields and custom properties and click the corresponding <Update> button.
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3.6. Planning

The Planning section is only available for installations of SpiraPlan® and SpiraTeam®, not SpiraTest®
and lets you configure functionality related to project estimation and planning.

3.6.1. Planning Options

The Planning Options page lets you configure the schedule and calendar options for the various project
estimation and planning modules. The settings are specific to each project:

Planning Options | Library Information System (Change Project)

The following schedule and calendar options are currently being used by this project. To change the settings
just modify the values and then click [Update] to commit the changes.

Once you are happy with the changes, it is recommended you refresh the schedule and progress information
in the project through the Data Caching administration screen.

General

Work Hours Per Day:* ] | hours
Work Days Per Week:* |57\ days
Non-Working Hours Per Month:* (g | hours
Effort Calculations:* [ Include Task Effort

[/ Include Incident Effort
[include Test Case Effort
Requirements

Default Estimate: [10 | points

Point Effort:* [Ba | hours [+ Suggest |

This is the conversion factor used to determine the number of person-hours per esfimated point

Auto-Create Tasks:™ [V] Create a new task when Requirement becomes ‘In-Progress’
Auto-Planned:*

Use Task Status:®

[ When you assign a release to a requirement, it changes to the ‘Planned' status automatically
[ When all tasks switch to Completed, the associated requirement will change status to Developed automatically.

Use Test Status:” [ \When all test cases are Passed, the associated requirement will change status to Tested automatically

asks & Incidenis
Default Effort (6.0 | hours

Tasks (Estimated Effort)

Time Tracking:* Enabled For Tasks
Enabled for Incidents

(» update |[+ Cancel

This page allows you to make changes to the following settings:
General

>» Work Hours Per Day — this setting allow you to specify how many work hours should be used
when converting an effort calculation from hours to calendar days. For example a 12 hour task
will occupy two days if you set the working hours per day to 6 hours, whereas the same task will
occupy 1 % days only if you set the working hours per day to 8 hours.

>» Work Days Per Week — this setting allows you to specify how many days in the week are
typically worked on the project. By default the system assumes a 5-day (Mon-Fri) working week,
but if your organization works Saturdays (for example), you may want to switch to a 6-day
working week. If you want to use partial days, then just round up to the nearest day and add non-
working hours (see below) to compensate.

» Non-Working Hours Per Month — this setting allows to specify how many non-working hours
typically need to be accounted for. This is useful if you want to have a working week that contains
a fractional number of days or if you have recurring activities that need to be removed from each
month. Note that if you have specific holidays, vacation days that need to be accounted for, it is
better to use the Release/lteration non-working time feature instead.

>» Effort Calculations — When calculating how much effort has been scheduled in a release or
iteration, the system will aggregate the individual effort values (both estimated and actual) for all
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the task, incident and test cases artifacts associated with the release/iteration. This setting allows
you to specify if you want only task, incident, or test case effort values to be included in the
releasel/iteration total. This is useful if your project management methodology requires that
incident or test case effort values be excluded from the total.

Requirements

>» Default Estimate — Normally when you create a new Requirement in the system it will be given
an empty initial estimate (in points). However if many requirements are typically a standard size,
then as a time-saver, the system will let you specify a default estimate value that will be used
when a new requirement is created.

» Point Effort — When requirements are added to the Planning Board or Iteration planning screen,
they will have an initial effort (in hours) that is used until tasks are added (see Auto-Create Tasks
option). This field contains the standard conversion factor used to convert points into hours based
on the current team velocity (how much time it takes on average to accomplish one story point).
As the project progresses, the team velocity will change, so you can click on the [Suggest] button
to have the system calculate how many hours each existing story point has taken to implement in
the project and provide that as a recommendation:

The fellowing point effort is recommended based on the current
projected task effort values in the current project

Default Effort: |8 8 | hours
(» Apply | [ Cancel
—

>» Auto-Create Tasks — When you change the status of a Requirement in the system to “In-
Progress” the system will automatically add a default Task to that requirement if no tasks already
exist. This is a useful shortcut that makes planning with requirements easier in the case when the
requirements are of a size where they don't need to be formally decomposed into multiple
developer tasks. However if you don’t want the system to automatically create tasks in, you can
deselect the option for the current project and it will turn off the feature.

>» Auto-Planned — When this option is enabled, if you assign a release/iteration to a requirement,
and the requirement is not already in the ‘Planned’ status, the system will automatically switch the
status of the requirement to ‘Planned'.

» Use Task Status — When this option is enabled, if you add any tasks to a requirement, the status
of the requirement will be automatically governed by the aggregate status of the associated tasks.

» Use Test Status - When this option is enabled, if you associate any test cases to a requirement,
the status of the requirement will be automatically switched from ‘Developed’ to ‘Tested’ when all
the associated test cases are passed.

Task & Incidents

>» Default Effort — Normally when you create a new Task in the system it will be given an empty
initial estimated effort. However if many tasks are typically a standard size, then as a time-saver,
the system will let you specify a default estimated effort that will be used when a new task is
created.

» Time Tracking — SpiraTeam® has an integrated time tracking system that allows the easy entry
of the hours spent on all assigned incidents and tasks in one place (see the SpiraTeam User
Manual for more details on this feature). This setting allows administrators to specify if they want
the integrated time tracking features enabled for both incidents or tasks (or neither).
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3.6.2. Task Workflows

Clicking on the “Edit Workflows” link under the Tasks heading, brings up the list of defined task workflows
for the current project. A workflow is a predefined sequence of task statuses linked together by “workflow
transitions” to enable a newly created task to be reviewed, prioritized, assigned, developed and tested, as
well as to handle exception cases such as the case of a blocked or deferred task. The workflow list
screen for the sample project is illustrated below:

Task Workflows | Library Information System (Change Project)

The following task types exist in the system. You can specify for this project, which workflows will be used for each task type:

Name Workflow ID

] | Development [ Default Workfiow A 000001
#] | Infrastructure [ Defautt Workfiow v| 000004
¥] | Management [ Dsfautt Workdiow v| 000003
¥] | Other | Default Workflow v | 000005
#]  Testing | Default Workflow v | 000002

There are the various Task workflows available in the project. To add a new workflow, click the Add Workflow link, to edit an existing
workflow, click on the Steps hyperlink:

Workflow Name Default Active  Workflow # Operations
[Default Workflow : ® (Yes V] WK000001 > Steps|Copy | Delete
> Add Workflow

The screen displays a list of all the standard task types in the system. The associated workflow drop-
down list allows you to specify which workflow the task type will follow. This is a very powerful feature
since it allows you to configure different workflows for different task types; i.e. a Development task may
follow a different process than an Infrastructure or Management task.

You can have as many workflows as you like in a project, but only one can be marked as the default.
Each task type must be assigned to a workflow. To modify the name, default flag, and/or active flag of an
existing workflow, simply change the values in the appropriate text-box, radio-button, or drop-down list
and click the <Save> button. To add a new workflow, simply click the ‘Add Workflow’ link and a new
workflow will be created with the standard SpiraTeam® steps and transitions.

Note: You can only assign an active workflow to a task type, and similarly you cannot make a workflow
inactive that is currently linked to a task type. This is important as all task types need to be linked to an
active workflow at all times.
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3.6.2.1. Edit Workflow Details

Clicking on the ‘Steps’ hyperlink of a workflow brings up the following screen that lists all the workflow
steps and workflow transitions that comprise the workflow:

View/Edit Workflow Steps | Default Workflow (Change Project)
<< Back to Workflow List
This displays all the Task status steps for this particular workflow:
Step Name Transitions Status # Operations

Not Started (Default) Defer Task (Delete) 000001 > Add Transition
== Deferred

Start Task (Delete)
=> In Progress

In Progress Block Task (Delete) 0oooo2 > Add Transition
=> Blocked

Complete Task (Delete)

=> Completed
Defer Task (Delete)
== Deferred
Restart Development (Delete)
== Not Started
Completed Reopen Task (Delete) 000003 > Add Transition
=> In Progress
Blocked Unblock Task {Delete) 000004 > Add Transition
> In Progress
Deferred Resume Task (Delete) 000005 > Add Transition
=> In Progress
Undefer Task (Delete)
== Mot Started

This page lists in the left-most column all the various task statuses defined in the system. The next
column lists all the possible transitions that can occur from that status. In addition, with each transition is
listed the name of the resulting destination status that the transition leads to. E.g. from the Not Started
status, depending on your role (see later) the user can move the task to either Deferred or In Progress,
depending on which transition the user takes.

Clicking on the name of a step or transition takes you to the appropriate details page (see below) where
you can set the properties of the step or transition respectively. To delete an existing transition, simply
click the ‘Delete’ hyperlink after the transition name, and to add a new transition, click the ‘Add Transition’
hyperlink in the Operations column.

3.6.2.2. Edit Workflow Transition

When you click on the transition name link from the previous screen, you are taken to the workflow
transition details screen:

Edit Workflow Transition | Start Task (WT1)
<< Back to Workflow Steps List

Not Started (1) ‘ = ‘ Start Task (WT1) | = | n Progress (2)

Workflow Transition Details

Name™: |jStar1 Task

» Save |[» Cancel

The top part of the screen is the “workflow browser” which illustrates how the transition relates to the
workflow as a whole. It displays the current transition in the middle, with the originating and destination
steps listed to either side. Clicking on either task status name will take you to the appropriate workflow
step details page. This allows you to click through the whole workflow from start to finish without having to
return to the workflow details page.
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This part of the screen lets you change the name of the transition In addition, each transition has a series
of conditions which need to be satisfied for a user to actually execute the transition (i.e. move the task
from the originating status to the destination status):

Conditions

The following users / roles are allowed to execute this transition:

Condition Type Condition Data
The author of this Task can execute:: | Mo W |

The owner of this Task can execute:: | Yes W |

Users with the specified roles can exscute: Project Owner:
Manager:
Developer:
Tester:

Observer:

Oo0D0d&A A

Incident User:

[» save |[» cancel |

The conditions section allows you to set three types of user role:

» The author of the task can be allowed to execute the transition. For example, when a task is
marked as Completed, the author might be allowed to move it to In Progress if there is still work
remaining.

» The owner of the task can be allowed to execute the transition. For example, when a task is

marked as In Progress, the assigned owner should be the only one who's allowed to move it to
Competed.

» A user with a specified role can be allowed to execute the transition regardless of whether they
are the author or owner. For example a user with role “Manager” might want the power to defer all
tasks regardless of ownership status.

You can set any of these conditions by changing the drop-down list and/or check-boxes and clicking
the appropriate <Save> button.

3.6.2.3. Edit Workflow Step

When you click on the task status name link from either of the previous screens, you are taken to the
workflow step details screen:

Edit Workflow Step Details | In Progress

=< Back to Workflow Steps List

| Reopen Task (WT6) ‘ = = | Block Task (WT5) ‘
Resume Task (WT7) | = = | Complete Task (WT3)

In Progress (2)
| Start Task (WT1) ‘ = = | Defer Task (WT4) ‘

| Unblock Task (WT3) ‘ = = | Restart Development (WT33)

The top part of the screen is the “workflow browser” which illustrates how the step relates to the workflow
as a whole. It displays the current task status in the middle, with the possible originating and destination
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transitions listed to either side. Clicking on either workflow transition name will take you to the appropriate
workflow transition details page. This allows you to click through the whole workflow from start to finish
without having to return to the workflow details page.

This page allows you to define the behavior of the various task fields (i.e. those that are a standard part of
SpiraTeam® such as Priority):

Task Fields

The following Task fields are hidden/dizsabled/required at this step in the workflow:
Field Name Hidden Disabled Required
Actual Effort d O O
Comments O O O
Creator d O O
Description d O O
End Date d O [
Est. Effort O O ™
Task Name d O O
Cwner d O )
Release O O i
Remaining O O O
Requirement d O O
Start Date d O )
Priority O O O
Type O O O

(- Update _

This page also allows you to define the behavior of the various task custom properties for this particular
step in the workflow:

Task Custom Properties

The following Task custom properties are hidden/disabled/required at this step in the workflow|

Name Type Hidden Disabled Required
Difficulty List O O O
Reviewer User O O O
(» U pdate

You can set each of the fields/custom properties as being:
» Hidden — The field / custom property will not be displayed when the task is in this status
>» Disabled — The field / custom property will be displayed, but will be greyed-out and read-only
>» Required — The field / custom property will be required when the task is in this status

Note that you cannot set a field/property as being required and either disabled or hidden since this would
prevent a user from ever updating the task. For example, when a task is in the Not Started status, you
might make the owner field hidden (since the author shouldn’t need to know who will ultimately own it),
when it gets to the In Progress status, you might make the field enabled and required, and when it gets to
the Completed status, you might make it disabled. This allows you to tailor the information gathered to the
appropriate place in the workflow.

To actually make these changes, all you need to do is select the appropriate checkboxes in the list of
fields and custom properties and click the corresponding <Update> button.
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3.7. Notifications

This section allows the administrator and project owner to configure email server configuration, email
notification content, and when notifications are sent. Server configuration and artifact templates can only
be changed by the system Administrator. However, notification events can be configured by the project
owner.

3.7.1 Email Configuration

The Email Configuration page is split into two sections. The first section covers email notification detalils,
and the second section configures how email from the application is sent.

Email Configuration
By default, SpiraTeam will use the default IS SMTP Virtual Server to send outgoing email notifications to users in the system. However, it can also be configured to send emails
through an external SMTP server directly.
This page allows you to change these mail server settings:
E-Mail Notifications Active? [tes v|
If disabled, SpiraTeam will not send out any messages

From E-Mail Address™: [administralor@mycompany.com |
The address that emails will be sent from. Replies to this address will not be monitored.
Reply-To E-Mail Address: ( |

The Reply-Te fizld that emails sent will contain. Blank will leave header field blank in
messages.

Send HTML Emails? [res v]

If enabled, emails will be sent out in HTML. Otherwise, plain text
Allow Users Control of Receiving | Yes v |
Emails?

If enabled, users will be given the option o deny receiving emails from the system.

e Email Notifications Active? — Defaults to Yes. If changed to No, the system will not send out
any emails, regardless of other settings. Note that this means that new user requests will not get
sent either.

e From Email Address — This is the email address specified in the ‘From:’ field of email
notifications sent from the application.

e Reply-To Email Address — This is the address specified in the ‘ReplyTo:’ field for notification
emails sent from the application.

e Send HTML Emails? — Defaults to Yes. This option specifies whether HTML or Plain-Text emails
are sent from the system.

e Allow Users Control of Receiving Emails? — Defaults to Yes. This specifies whether or not a
user can modify their profile to not receive any emails from the system. If set to no, users’
preference will be enabled and locked out.

Mail Server
Please leave all the following fields empty if you want to use the default [IS SMTP Virtual Server:

Host Name: (
The SMTP host name of your mail server.

Port Number: FE
The SMTP port number to use. Blank to use default of 25.

SSL Connection: |Nc17'|

User Name: | |
If your SMTP requires authentication, this is your username.

Password: | |

It your SMTP requires authentication. this is your password.

(» Update
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To use the internal IIS’s default virtual SMTP server, leave all fields blank. The virtual server must then be
configured to use proper SMTP server and network configuration. If you want the application to contact
an SMTP server directly, use the following fields:

e Host Name — This is the SMTP server to connect to.
e Port Number — This is the port number to use, blank uses the default port 25.

e SSL Connection — Whether or not to use an SSL connection with the server. Be sure that the
SMTP server’'s SSL certificate is trusted on the application server.

e User Name — When using an authentication method, this is the username to log in as.
e Password — When using an authentication method, this is the password to use.
Example settings for connecting to Gmail/Google Mail for sending natifications:
« Host Name: smtp.gmail.com
% Port Number: 587
% SSL Connection: Yes
« User Name: <account>@gmail.com

< Password: <account password>

3.7.2 Notification Templates
Notification templates are used by notification events, and are defined system-wide for each artifact type.

Notification Templates

Here you can specify the e-mail notification templates sent out for
each Artifact type. To edit the template, selact the Edit Template
link.

To send a test e-mail using the template, select the Test
Template link. The test e-mail will be sent using the first item in
the project.

Artifact Type Prefix Operations
Reguirement RQ Edit | Test
Test Case TC Edit | Test
Incident IN Edit | Test
Task TK Edit | Test
Test Set X Edit | Test

To edit a template, click the Edit link. To send a test email notification to yourself using the specified
template, click the Test link.

Clicking the Edit link will take you to a page similar to the following. Depending on the artifact type you
selected, the list of available fields will vary.
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Notification Templates | Requirement
<= Return to Template List

The template below will be sent whenever an event is matched for an artifact Requirement. Tokens in the template will be substituted when an e-mail is set. Otherwise, the template will
be sent as-is to assigned users and roles.

[=Font - V|[se- V| Bz U|E

| | —ee @ oA

${Product}

Requirement: ${Name} (${ProjectName})
${Description}

A change has been made to this requirement:
Reguirement: ${ID#}
Owner: ${Owner} v
Importance: ${importance}

The following are all available tokens for Requirements and their meanings. Tokens not in this list will be taken out of the final message. Click on a token to insert it inte the current
cursor pesition in the editor above.

${Author} The name of the Author ${Comments} The requirement comments
${Component} The component the requirement is a part of ${Description} Descriptive text

${EstimatePoints} The estimate in story/function points ${lmportance} The current Importance

${Name} Name of the Requirement ${Owner} The name of the Owner

${Release} The Requirement's Assigned Release. ${RequirementStatus} The current Status
${RequirementType} The requirement type ${TaskActualEffort} Assigned Task's actual effort in HH:MM
${TaskEstimatedEffort} Assigned Task's planned effort in HH:MM ${TaskProjectedEffort} Assigned Task's projected effort
${TaskRemainingEffort} Assigned Task's remaining effort ${URL} URL to link to artifact

${NotifyTo} The notification receiver's name. ${Product} The name of the application.
${ProjectName} The name of the project S{ID#} The ID# of the item.

On this screen you are presented with the same rich text editor available elsewhere in the application.
Displayed in it is the current template (with template tags showing) for the artifact. Template tags start
with a $ (dollar sign) and then a string name enclosed in () parentheses. When email notifications are
sent, tokens will be replaced with specific information from the artifact that the notification is being sent
for. Invalid tokens will be stripped from the template text. Clicking a token in the list will insert it in the
current position in the textbox for easy selecting and editing.

If HTML notifications are disabled, the template will be converted to plain text before sending.
When finished, click the update button to save your new template. The new template will take effect
immediately.

3.7.3 Notification Events

The Notification Events section is where project managers can set up when and to whom notifications are

sent out to users of the system. Clicking on the Notification Event link will present you with a list of all
events defined for the current project:
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Notification Events | Library Information System (Change Project)

The following notification events have been defined for this project. To activate or deactivate an event or change
assigned fields or users, click the 'Edit’ link.

Event Name Artifact On Creation? Active? Operations

Incident: Newly Created Incident Yes Yes Edit | Delete
Incident: Owner Assigned Incident Mo Yes Edit | Delete
Requirement: Newly Created Requirement  Yes Yes Edit | Delete
Requirement: Owner Assigned / Importance Requirement  No Yes Edit | Delete
Task: Mewly Created Task Yes Yes Edit | Delete
Task: Owner or Priority Changed Task Mo Yes Edit | Delete
Test Case: Executed Test Case No Yes Edit | Delete
Test Set: Execution Changed Test Set Mo Yes Edit | Delete
Test Set: Newly Created Test Set Yes Yes Edit | Delete

Mote that these events do not override nor cancel any notifications configured for Incident Workflows. To adjust
settings based on Incident Status changes and workflow steps, please go to the View/Edit Workflow page.
== Go to Edit Workflows

Note: These events can handle all changes to any of the artifacts except changes handled by Status
changes to Incidents. Incident status changes are handled through the Workflow configuration.

When clicking on the Edit link or Add button, you will be presented with the event details screen:

Notification Event Details | Incident: Owner Assigned
<< Back to Notification Event List

Event details are listed below. You can edit the fields and users and whether or not this event is fired on creation, but once created the Artifact Type cannot be changed.
Once finished, click [Update] or [Insert] to save your changes.

Event Name:* [Incident: Owner Assigned J

Artifact Type:*

This event will be attached to this ariifact type.
On Creation?:* [Ne V|
Whether this event is fired on a new arfifact creation.

Subject Line:* |:${Pmduct} - Incident ${ID#} has been assigned to you.

The subject-ling of the e-mail notification. Tokens used in the email template can be used in the subject line.

Configuration:
Artifact Fields Users and Project Roles

The top section defines general configuration items for the event:
e Event Name: used to name the event, only used for administrative purposes.

e Artifact Type: The artifact type this event is attached to. Once an event is created, the artifact
type cannot be changed.

e On Creation? If set to yes, this event will fire when an artifact is created, as well as when any
configured fields are changed.

e Active? If set to yes, this event is active and will send notifications when configured fields are
modified.

e Subject Line: The subject line of the notification email.

The Artifact Fields will let you configure which fields will cause this notification to send an email
notification:
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Artifact Fields Users and Project Roles
This event will be active if any of the selected fields are changed.
Field Notify On Change?
Actual Effort
Fixed Build
Closed On
% Complete
Description
Detected Release
Est. Effort
Type

Name

ooooononoD .

Selected fields are treated in an OR-based query, so that if you have two or more fields checked for an
event, the event will send a notification if either of the two fields are changed. Depending on the artifact
type configured above, the available fields will vary.

The last section is the configuration of whom to send the notifications to:

Artifact Fields Users and Project Roles
When a selected field is changed, the following users or roles will be notified.

User [ Project Role Enabled?
Artifact Opener or Creator: O

Artifact Owner: ]
Project Roles:

Project Owner:

Manager:

Developer:

Tester:

Observer:

OoooodX

Incident User:

If a user belongs to more than one group or they have manually signed up to receive notifications to any
changes in the artifact, they will only receive one notification for the artifact change.

3.8. Documents

SpiraTeam® includes a built-in web-based document management system that allows you to upload and
share documents between project team members. These documents are stored in folders, categorized by
a series of user-defined meta-tags and can also be associated with other artifacts in the system (e.g.
requirements, incidents, etc.).

The set of administrative options located under the “Documents” heading allow the Project Owner to
configure how the documents are organized in their particular project.
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3.8.1. Edit Document Types

When users upload documents into a SpiraTeam project, they are required to specify the type of
document that is being uploaded. The list of document types is configurable by the Project Owner for
each individual project.

When you click on Documents > Edit Types, you can edit the list of types available:

Edit Document Types | Library Information System (Change Project)

The following document types have been created in this project. Please make any changes and click [Add] or [Update].
To remove an existing document type just make it inactive by setting its Active flag to No

ID Name Description Default Active

DTD00001 [Default ] [The default document type for a project ] |E|
DTD00002  [Functional Specification | | |Functional specification for the system. Can be performance or feature related | ® |E|
DT000003 (Sereen Shot I _\ [res )
DTO00004 | [stack Trace ] ] @] |E|
DTO0000% | [uML Diagram | | [UML documents such as sequence diagram, state diagram. use-case diagram, class diagram, etc. | |Yes—"|
DTO00006  [Screen Layout | | |E|

By default, each project will be created with a single document type called ‘Default’. You can add
additional document types and/or change the name of the ones already created. If you decide that you no
longer want to use a specific document type, you can set its active flag to “No”.

The only requirement is that each project needs to have at least one active document type available, and
that there is one active type designated as the default type. The default type is the option that will be
initially selected when a user uploads a file / URL to the project.

3.8.2. Edit Document Folders

In addition to associating the documents in the system with a “document type”, they can also be
organized into a hierarchy of folders. Clicking on Documents > Edit Folders allows the Project Owner to
create / modify the folder structure into which users can upload the documents for sharing and
collaboration:

Edit Document Folders | Library Information System (Change Project)

The following document folders have been created in this project. Please click on the link to edit an existing folder, or click on the [Add] button to create a new folder in the project:
1D Name Operations
DF000001 B Root Folder > Edit | Delete
DF000014 B> CreateNewAuthor = Edit | Delete
DFOOOD1S > CreateNewBook > Edit | Delete
DF000007 [E= Design Documents > Edit | Delete
DF000016 7= EditExistingAuthor > Edit | Delete
DFO00017 [P EditExistingBook > Edit | Delete
DFO00008 = Misc Documents > Edit | Delete
DFO00003 B> Screen Captures > Edit | Delete
DFO00002 > Specifications > Edit | Delete
DFO00004 [E= Test Results > Edit | Delete
DF000005 B> Error Messages > Edit | Delete
DFO00006 = Web Links > Edit | Delete
DF000012 [E= Test Scripts > Edit | Delete

Initially, new projects are created with a single folder called “Root Folder”, under this folder, you can click
the [Add] button to add additional folders, “Edit” to change the name and/or location of an existing folder,
or “Delete” to permanently remove a folder. Note that deleting a folder will remove all its subfolders and
any documents contained in the folder and subfolders.

When you click on either [Add] or “Edit”, you will be taken to the following screen that allows you to edit
the details of the new/modified folder:
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Add / Edit Document Folder | New Folder

Please review the information listed below and make any changes if necessary.
Once you have finished, click [Update/Insert] to confirm them.

Folder Name:* [Design Documents x|
Parent Folder: [Root Folder V|
T

The first field allows you to specify the name of the folder as it will be displayed to users in the system,
and the second field allows you to tell the system which parent folder should contain the new folder. You
cannot make the root folder a child of an existing folder, and there can only be a single root folder per
project.

3.9. System

3.9.1. General Settings

The general settings page allows you to configure SpiraTeam® to better match your environment and
setup. In the current version, you can specify the default language, configure the folder used to store
document attachments and also the type of text editing for the longer, descriptive text fields used in the
application (e.g. a test case’s description):

General Settings

This page allows you to modify the general SpiraTeam system settings

Default Culture: | — Server Default — V|

The culture used to determine which number/dste formats to use and which language to use

Default Timezone: "/ Server Default — '.\

The fimezone used (o determine how dales and fimes are d\spléyed in the system.

Web Server URL" \:http INocalhostiSpiraTest

The base URL used to atcess SpiraTeam (e.g. hifpimyserver/SpiraTeam)

Attachments Folder™: \:C.\Su bversion\Projects\SpiraTeam\Trunk\SpiraTest\Attachments |

The folder used to store file aftachments (e.g. C\Program Files\SpiraTeamiAttachments)

Cache Folder ‘ |

The local folder used by the web process to store cache data. By defsult or in emor, the folder is
C:\PregramDatz\Inflectra\Spira

Rich Text Editing* "\’es v Use rich-text editing for artifact descriptions
"\’es v| Use rich-text editing for test step list
Instant Messenger™ "\’es v| Enables use of the integrated instant messenger.

(90 |days

The number of days that read instant messages are retained in the system

Display Build During Test Execution®: ‘.\’eg v|
Auto Unassign Tests™ ‘.‘]’eg v| Passing a test case unassigns it from its cwner
"\’es v| Completing a test set unassigns it from its owner

Event Log Retention®:

30 | days

The number of days that error messages are retained in the system event log

» Update

The available settings include:

o Default Culture — SpiraTeam can display information in a variety of different languages
(assuming that the appropriate language packs have been installed) and number formats. By
default, SpiraTeam will use the regional settings (language and number formats) of the operating
system it has been installed on. However, you can override this default by choosing the
appropriate culture from the list of options displayed in the drop-down list. Note: The list of culture
options does not reflect the available language packs, so in some cases, the setting will only
change the number formats.
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Default Timezone — SpiraTeam stores all dates and times internally in Universal Coordinated
Time (UTC) and can therefore display dates/times adjusted for different timezones. By default,
SpiraTeam will display dates in the timezone specified in the operating system it has been
installed on. However, you can override this default by choosing the appropriate display timezone
from the list of options displayed in the drop-down list.

Web Server URL — This is the URL that your users use to access the system. Do not put the
/Login.aspx or any other page here, as this URL is used to generate links to pages in the
application.

Attachments Folder - By default when SpiraTeam® is installed, the document attachments
uploaded in the system get stored inside the C:\Program Files\SpiraTeam\Attachments folder
located inside the main SpiraTeam® installation root. However you may want to have the
documents stored on a remotely mounted drive or on a different hard disk partition. In which case
you can simply change the folder pointed to in the text-box illustrated above and then click
[Update] to commit the change.

Cache Folder — By default when SpiraTeam needs to store temporary data (generated reports,
the version control cache, etc.) it will store them in the C:\ProgramData\Inflectra\Spira folder.
Sometimes this folder is not appropriate (e.g. you want them on a different drive that has more
space). You can enter in a different folder for temporary storage and SpiraTeam will use that
instead.

Rich Text Editing - When editing certain text fields inside the system, the user is presented with
a ‘rich-text’ interface that allows them to set the formatting of the text using a toolbar:

e
11
111
[eal]
U]
[T

[Fort] ~ [Szz] -~ B I U|

E | hd|—eepgOo@

Sample application that allows users to manage books, authors and lending records for a typical branch library

In addition this toolbar includes the option to insert bulleted lists, tables, links to other websites
and other text effects. However this functionality can cause certain pages in the application to
load more slowly on some browsers (e.g. Internet Explorer 6.0 or earlier) — especially on the test
case details screen, which has rich-text editors for each of the test steps.

If you experience performance issues, you can use the configuration options on this page to turn
off rich-text editing for just the test steps (which causes the most performance issues) or for both
the test steps and for the various other description text-boxes. You can change this setting at any
time, but any existing formatted text will appear as HTML markup if you switch from rich-text to
back to plain-text on an existing installation.

Instant Messenger — SpiraPlan and SpiraTeam come with a built-in instant messenger that
allows users to communicate with each other in real-time. This can result in higher levels of
network traffic and some system administrators may wish to disable this feature. This option lets
you disable the integrated instant messenger. In addition, you can specify how long (in days)
instant messages are retained in the system.

Display Build During Test Execution — During test execution the system can display a drop-
down list of builds associated with the selected release. If you are using SpiraTeam in conjunction
with a build server such as Jenkins/Hudson, you should choose “Yes”, otherwise we recommend
hiding the list of builds (to avoid confusing your testers) by choosing “No”.

© Copyright 2006-2014, Inflectra Corporation Page 67 of 96 This document contains Inflectra proprietary information




e Auto Unassign Tests — When a tester passes an assigned test case or all the test cases in an
assigned test set the system by default will automatically un-assign the test case / test set from
the user. To prevent this from happening, simply change the setting to “No”.

e Event Log Retention — As described in section 3.9.7, SpiraTeam comes with a built-in diagnostic
event log. By default the system will only retain the last 30-days of events to avoid wasting
storage space. You can adjust the retention period in this section to match your organization’s
policies.

3.9.2. File Type Icons

The “File Types List” administration page allows you to view all the different filetypes that are recognized
by SpiraTeam and add or edit the associated icon, name, description and MIME type:

File Types List

This is the list of configured filetypes. their icons displayed in the application, and the mimetypes reportedfor them. Note that any undefined file extensions are still allowed, they will just be
shown as 'Unknown' in the application.
Extension lcon  Description Mime Type Operations

& Other File Type application/octet-stream

ai k-] Adobe lllustrator application/illustrator Edit | Delete
asp B Active Server Page textiplain Edit | Delete
aspx B ASP Page text/plain Edit | Delete
bmp 2] BMP Image image/bmp Edit | Delete
[ =) C Source text/plain Edit | Delete
chm ® Compiled Help application/octet-stream Edit | Delete
cpp 2] C++ Source textiplain Edit | Delete
cs | Ci# Source textiplain Edit | Delete
css ] Stylesheet textiplain Edit | Delete
dil 1% Assembly application/octet-stream Edit | Delete

If you click on the “Edit” hyperlink next to a filetype, or click on the <Add> button at the bottom of the
screen, the system will display the page that lets you add or edit a filetype entry:

Edit / Add File Type | Return to Template List

This is the definition for the file type with the given extension. Entering in values here simply helps with displaying correct file information on the Source Control and Documents pages
with attachments. All fields are required, blank fields will be set to the default. The icon image must exist on the web server in the active theme directory under "Fileiypes”

Filetype 1D:

File Extension: [asp |

File Description: [M]

Mime Type: [textiplain |
File Icon Image: [Active-Ser\rer-Page gif |

On this page you can enter/edit the file extension that's used to recognize the type of file uploaded, the
description of the file type (displayed in popup tooltips), the MIME type (used to determine how the
browser handles the file type) and the path to the icon image. Once you are satisfied with the values, you
can click on the <Update> button to confirm the changes.

3.9.3. Edit Reports

The “Edit Reports” administration page lets you create custom reports in the system, that your users can
run in the various projects they have access to. Note that the report definitions themselves are global to
the system and therefore available in all projects.
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Edit Reports
This page displays the various reports that are available in the system. The reports listed as ‘Default’ are part of the system and cannot be modified, however you can add a new
report or copy an existing report for modification using the options below:
Category Name Active Default Operations
“3 Requirement Reports | Copy of Requirements Detailed v > Edit | Copy | Delete
] Requirement Reports | Requirements Detailed v v > View | Copy
7] Requirement Reports | Requirements Plan v v > View | Copy
7] Requirement Reports | Requirements Summary v v > View | Copy
7] Requirement Reports | Requirements Traceability v v > View | Copy
&7 TestCase Reports | Printable Test Scripts v v > View | Copy
&) TestCase Reports | Test Case Detailed v ¥ |> View| Copy
&7 TestCase Reports | Test Case Summary v v > View | Copy
L TestCase Reports | Test Case Traceability v ¥ |> View| Copy
&7 TestCase Reports | Test Run Detailed v v > View | Copy
& TestCase Reports | Test Run Summary v v | > View | Copy
&7 TestCase Reporis | Test Set Detailed v v > View | Copy
& TestCase Reports | Test Set Summary v ¥ | > View | Copy
®7  Incident Reporis Incident Detailed v v > View | Copy
¥  Incident Reports Incident Summary v ¥ | > View | Copy
#] Task Reporis Task Detailed v v > View | Copy
#9  Task Reports Task Summary v ¥ |>View| Copy
[ Release Reporis Release Detailed v v > View | Copy
[ Release Reports Release Plan v ¥ | > View| Copy
[ Release Reporis Release Summary v v > View | Copy
> Add New Report

The list of report definitions contains both the standard (default) reports that ship with the system and any
custom reports that you have defined. However any of the reports listed with the “Default” option checked
will not be editable. So, if you want to modify one of the built-in reports to make it better suit your needs,
you should instead click on the “Copy” hyperlink next to the report and make a copy of the report that you
can then modify. You can view any of the default reports by clicking on the associated “View” hyperlink.

To edit an existing non-default report, click on the “Edit” hyperlink. To add a new report from scratch,
simply click on the “Add New Report” option at the bottom of the list. Either of these will take you to the
Report editing screen:

Report Details | Copy of Requirements Detailed

This page displays the details of a specific report. For user-defined reports you can specify the formats, define the sections and provide a header/footer that should be included:

Name:* |Copy of Requirements Detailed |

Description: This report displays all of the requirements defined for the current praject in the order they appear in the requirements list. The requirement's details and
coverage status are displayed, along with sub-tables containing the list of covering test cases, linked incidents/requirements, attached documents,
associated tasks, linked artifacts and the change history

Header: [~ Font - V|[-sze- V]| B Z U|E==|i E| | —epmo @
This report displays all of the requirements defined for the current praject in the order they appear in the requirements list. The requirement's details and
coverage status are displayed, along with sub-tables containing the list of covering test cases, linked incidentsirequirements, attached documents,
associated tasks, linked artifacts and the change history

Footer ~Fonl - V|[-sz=- V]| B 7 U|ESE|ZEEE | HE| —e@pOe@

Active:* 7

Category:* [Requirement Reports v|

The top-half of this screen (illustrated above) lets you specify the name of the report, the long description
(displayed in tooltips but not in the report itself) and a rich-text footer and header. The header and footer
will be displayed at the top and bottom of the generated report.

In addition, you can specify whether the report is active (and therefore can be used in the SpiraTeam
reports center) and which report category heading the report will appear in. This is also used to determine
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which role(s) are able to run the report (e.g. a user that has permissions to view requirements will be able
to run all reports listed under the “Requirement Reports” category).

The lower-half of the screen displays the list of formats, standard sections and custom sections that make
up the report:

Formats:™ Format

7] T Adobe Acrobat
7 &) HTML
E]  MS-Excel 2003+
] | MS-Excel 2007+
v @) MS-Word 2003+

7 ] MS-Word 2007+

XML
Standard Sections:” | Name Active Operations
Project Overview v > Customize | Delete
] | Requirements Details v > Customize | Delete
» Add New Standard Section
Custom Sections:™  Name Active Operations

» Add New Custom Section

(» Update |(» cancel |

The list of formats is fixed in the system, you can simply choose which formats this specific report will be
available in. The reporting engine will take care of converting your report into the target format, you just
need to specify which type(s) are applicable.

a) Standard Sections

The list of standard sections contains a list of the various pre-defined report sections that are to be
included in the report. A standard section consists of a set of nested queries and embedded elements
that will return back data. For example, the “Requirements Details” section consists of a list of all the
requirements in a project, together with the associated test cases, tasks, custom properties, attachments,
discussions, change history, source code revisions and other related items.

With a standard section, you cannot change the underlying data query, but you can change the header,
footer and XSLT template used to format the results:
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Name:* |' Requirements Defails v'\ > Create Default Template

Description: This section displays all of the requirements in a document format with embedded tables for each of the associated elements.

Header [T Foni - E==|EEEE|hH%|—=pdo@

null

Footer: [~ Font— v|(-sz=- V| B I U : || —emoo@

null

Template:  [<?xml version="1.0" encoding="utf-8"?>
<xsl:stylesheet version="1.0" xmins:xsl="http:/fwww.w3.org/1999/XSL/Transform" xmlns:msxsl="urn:schemas-microsoft-com:xslt" exclude-
result-prefixes="msxsl">
<xsl:template match="/RequirementData">
<xsl-for-each select="Requirement"=
<divz v

val-aftrihuta nama="chila"

You need to enter the XSLT Template for displaying the retrieved data as HTML. When you first add the section, the default template for this section will be included. You can modify

Update

When you either click on “Add New Standard Section” or the “Customize” link next to an existing standard
section, the popup dialog illustrated above will be displayed. On this page you can change the following
fields:

e Name — Choose the name of the standard report section you want to use from the dropdown list.
Changing the name of the section will automatically update the Description field below.

e Description — This is the description of the report section, it is not displayed in the final report.

e Header — This is the header that will be displayed before the dynamic data retrieved as part of
the report section. You can enter in formatted rich text in this field.

e Footer — This is the footer that will be displayed after the dynamic data retrieved as part of the
report section. You can enter in formatted rich text in this field.

e Template — This is the eXtensible Markup Language Stylesheet Transform (XSLT) used to
transform the raw XML data from the report query into the final HTML display format. When you
choose/change the name dropdown list, clicking on the “Create Default Template” will populate
this field with the default template used to render the data.

When you first create a new standard report section, we recommend using the option to “Create Default
Template”. This will then allow you to run the report in the main reports center and have all the available
data fields displayed in the standard format. If you would like to customize the content of the section, you
have several options:

e Customize Header/Footer — if you want to keep the data and layout as-is, you can simply add a
custom header and footer to add organization specific information into the report.

e Customize the Data/Layout — if you want to customize how the data is displayed and formatted,
you will need to edit the XSLT Template. You can learn more about XSLT at the W3Schools
website (http://www.w3schools.com/xsl). However, the recommended approach is to first run the
“Raw XML" format report from the main SpiraTeam reports center. An example XML report is
partially shown below:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<Report>
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http://www.w3schools.com/xsl

<Title>
Requirements Detailed Report
</Title>
<ProjectData>
<Project>
<Projectld>1</Projectld>
<ProjectGroupld>2</ProjectGroupld>
<Name>Library Information System</Name>
<Description>Sample application that allows users to manage books, authors and lending
records for a typical branch library</Description>
<Website>www. libraryinformationsystem.org</Website>
<CreationDate>2005-11-30T19:00:00</CreationDate>
<ActiveYn>Y</ActiveYn>
<WorkingHours>8</WorkingHours>
<WorkingDays>5</WorkingDays>
<NonWorkingHours>0</NonWorkingHours>
<TimeTracklIncidentsYn>Y</TimeTracklncidentsYn>
<TimeTrackTasksYn>Y</TimeTrackTasksYn>
<EffortincidentsYn>Y</EffortincidentsYn>
<EffortTasksYn>Y</EffortTasksYn>
<TasksAutoCreateYn>Y</TasksAutoCreateYn>
<RegDefaul tEffort>480</RegDefaul tEffort>
<TaskDefaul tEffort>360</TaskDefaul tEffort>
<ProjectGroupName>Internal Projects</ProjectGroupName>
</Project>
</ProjectData>
<RequirementData>
<Requirement>
<Requirementld>1</Requirementld>
<Projectld>1</Projectld>
<ScopelLevel 1d>3</ScopelLevel 1d>
<Authorld>2</Authorld>
<Name>Functional System Requirements</Name>
<CreationDate>2003-11-30T19:00:00</CreationDate>
<LastUpdateDate>2003-11-30T19:00:00</LastUpdateDate>
<IndentLevel>AAA</IndentLevel>
<ExpandedYn>Y</ExpandedYn>
<VisibleYn>Y</VisibleYn>
<SummaryYn>Y</SummaryYn>
<AttachmentsYn>N</AttachmentsYn>
<CoverageCountTotal>21</CoverageCountTotal>
<CoverageCountPassed>10</CoverageCountPassed>
<CoverageCountFailed>3</CoverageCountFailed>
<CoverageCountCaution>1</CoverageCountCaution>
<CoverageCountBlocked>1</CoverageCountBlocked>
<PlannedEffort>8700</PlannedEffort>
<TaskEstimatedEffort>11400</TaskEstimatedEffort>
<TaskActualEffort>7570</TaskActual Effort>
<TaskProjectedEffort>3855</TaskProjectedEffort>
<TaskRemainingEffort>11485</TaskRemainingEffort>
<TaskCount>42</TaskCount>
<TaskPercentOnTime>59</TaskPercentOnTime>
<TaskPercentLateFinish>6</TaskPercentLateFinish>
<TaskPercentNotStart>7</TaskPercentNotStart>
<TaskPercentLateStart>28</TaskPercentLateStart>
<ScopelLevelName>In Progress</ScopelLevelName>
<AuthorName>Fred Bloggs</AuthorName>
<HasDiscussionChanged>false</HasDiscussionChanged>
<IsDeleted>false</IsDeleted>
<CustomProperties>
<CustomProperty>
<Alias>URL</Alias>
<Name>Custom_01</Name>
<Type>Text</Type>
</CustomProperty>
<CustomProperty>
<Alias>Difficulty</Alias>
<Name>Custom_02</Name>
<Type>List</Type>
</CustomProperty>
<CustomProperty>
<Alias>Requirement Type</Alias>
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<Name>Custom_03</Name>
<Type>List</Type>
</CustomProperty>
<CustomProperty>
<Alias>Notes</Alias>
<Name>Custom_04</Name>
<Type>Text</Type>
</CustomProperty>
<CustomProperty>
<Alias>Review Date</Alias>
<Name>Custom_05</Name>
<Type>Date</Type>
</CustomProperty>
<CustomProperty>
<Alias>Decimal</Alias>
<Name>Custom_06</Name>
<Type>Decimal</Type>
</CustomProperty>
</CustomProperties>
<Discussions />
<TestCases />
<Tasks />
<Attachments />
<History>
<HistoryChangeSetType>
<ChangeTypeld>1</ChangeTypeld>
<ChangeTypeName>Modi fied</ChangeTypeName>
</HistoryChangeSetType>
<HistoryChangeSetType>
<ChangeTypeld>2</ChangeTypeld>
<ChangeTypeName>Deleted</ChangeTypeName>
</HistoryChangeSetType>
<HistoryChangeSetType>
<ChangeTypeld>3</ChangeTypeld>
<ChangeTypeName>Added</ChangeTypeName>
</HistoryChangeSetType>
<HistoryChangeSetType>
<ChangeTypeld>4</ChangeTypeld>
<ChangeTypeName>Purged</ChangeTypeName>
</HistoryChangeSetType>
<HistoryChangeSetType>
<ChangeTypeld>5</ChangeTypeld>
<ChangeTypeName>Rol Iback</ChangeTypeName>
</HistoryChangeSetType>
<HistoryChangeSetType>
<ChangeTypeld>6</ChangeTypeld>
<ChangeTypeName>Undelete</ChangeTypeName>
</HistoryChangeSetType>
<HistoryChangeSetType>
<ChangeTypeld>7</ChangeTypeld>
<ChangeTypeName>Imported</ChangeTypeName>
</HistoryChangeSetType>
<HistoryChangeSetType>
<ChangeTypeld>8</ChangeTypeld>
<ChangeTypeName>Exported</ChangeTypeName>
</HistoryChangeSetType>
</History>
<Requirements />
<Incidents />
<SourceCodeRevisions />
</Requirement>
</RequirementData>
</Report>

This XML data is then converted by the XSLT template into HTML format so that it can be included into
the final generated report. An example fragment of the XSLT template looks like:

<?xml version="1.0" encoding="utf-8"?>

<xsl:stylesheet version="1.0" xmIns:xsl="http://www.w3.0rg/1999/XSL/Transform"

xmIns:msxsl=""urn:schemas-microsoft-com:xslt" exclude-result-prefixes="msxsl">
<xsl:template match="/RequirementData'>
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<xsl:for-each select="Requirement'>
<div>
<xsl:attribute name="style'">
padding-left: <xsl:value-of select="string-length(IndentLevel)*2"/>px;
</xsl:attribute>
<xsl:if test="SummaryYn="Y"''>
<div class="Title2">
RQ:<xsl:value-of select="Requirementld"/> - <xsl:value-of select="Name"/>
</div>
<div class="Description'>
<xsl:value-of select="Description’” disable-output-escaping="yes"/>
</div>
<br />
</xsl:if>
<xsl:if test="SummaryYn="N"">
<xsl:attribute name="style'">
padding-left: <xsl:value-of select="string-length(IndentLevel)*2"/>px;
</xsl:attribute>
<div class="Title3">
RQ:<xsl:value-of select="Requirementld"/> - <xsl:value-of select="Name"/>
</div>
<p>
<xsl:value-of select="Description’ disable-output-escaping="yes"/>
</p>
</xsl:if>
</div>
</xsl:for-each>
</xsl:template>

So using a combination of XSLT and the Raw XML report format, you can generate a customized view of
the standard report section that will be included in the final report.

Sometimes, however you want to be able to create a completely custom report that includes customized
data as well as a custom format. In which case you need to use a custom report section instead.

b) Custom Section

Back on the main report details page:

Formats:* Eormat

) Adobe Acrobat
g| HTML

& | MS-Excel 2003+
MS-Excel 2007+
] | M5-Word 2003+
i) | MS-Word 2007+

o | XML

RO O & E]
i)

Standard Sections:® | Name Active Operations

Project Overview v > Customize | Delete

=] | Reqguirements Details v » Customize | Dele

= Add New Standard Section
Custom Sections:®  Name Active Qperations

> Add New Custom Section

[» save |(» Cancel |

If you click on “Add New Custom Section”, the following dialog box will be displayed:
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Add/Edit Custom Section

Name:*

Description: [Thisz new custom section contains a table of the requirements name and 1Ds

[List of Requirement Names and IDs ] il

Header: [~ Font - Vi[-s=- V| B 7 U|ESE|EIZEE|EE|—=@OC@
This new custom section contains a table of the requirements name and IDs 3
Footer: [~ Font - V|[-s=- V] B 7 U|=S==]|i=; £ d|—epoo@
(C) Copyright MyCompany 2013
Active:*
Query:* [—Md New Query — vl | Preview Results | Create Default Template

On this page you can enter / change the following fields:

Name — Enter the name of the new custom report section that you will be adding to the report.

[ ]
This is not displayed in the final report
e Description — This is the description of the custom section, it is not displayed in the final report.
e Header — This is the header that will be displayed before the dynamic data retrieved as part of
the report section. You can enter in formatted rich text in this field.
e Footer — This is the footer that will be displayed after the dynamic data retrieved as part of the
report section. You can enter in formatted rich text in this field.
e Active — You should make sure this checkbox is checked if you want the custom section to
appear in the final report.
Further down on the page you can actually enter the custom query and associated XSLT template:
Add/Edit Custom Section
Active:*
Query:* Requirements ¥| | Preview Results | Create Default Template
select value R from SpiraTestEntities. R_Requirements as R where R PROJECT_ID = §{Projectld} s
“You need to enter the SQL command for retrieving the report data. You can use the special lokens ${Projectid} and ${ProjectGroupld} to limit the query to a specific pmj:clurprcje:lv
group. WARNING: If you do not specify either of these parameters. the repart will retrieve data for all projects in the system, regardiess of the user's role or permissions.
Template:* = |=

“You need o enter the XSLT Template for dispiaying the retrieved data as HTML. When you click the ‘Create Defauit Template' option. the system will automatically generate a default
XSLT template that you can el i

(- Update (> Cancel




On this page you need to first choose the appropriate reportable entity from the dropdown list. In the
example illustrated above, we have selected the “Requirements” reportable entity. This will automatically
populate the following query in the Query editor:

select value R from SpiraTestEntities.R_Requirements as R where R.PROJECT_ID = ${Projectld}

This query tells SpiraTeam to select all of the rows in the R_Requirements collection that are in the
current project and include all of the columns in the final report. This generally will result in more columns
than is desirable, so you should click on the “Preview Results” option to view a list of the various columns
and the sample data. That will help you decide which columns are important for your report. You can then
adjust the query to only include those columns:

select R.REQUIREMENT_ID, R.NAME from SpiraTestEntities.R_Requirements as R where R.PROJECT_ID =
${Projectld}

In this modified query, we have replaced the keyword value with the specific column names. When you
use the “Preview Results” option on this query, you will only see the two desired columns:

Add/Edit Custom Section

Active | CUStom Query Results

Query:* REQUIREMENT_ID NAME -
Functional System Requirements d} -
Online Library Management System
Book Management

Ability to add new books to the system
Ability to edit existing bocks in the system .
Ability to delete existing books in the system lto a specific project or project
Ability to associate books with different subjects or permissions

Ability to associate books with different authors

Ability to associate books with different editions

Ability to completely erase all books stored in the system with one click

A

Template:*

m

2w @ s W

=

litomatically generate a default

;

4

Once you have verified that the data being returned matches your requirements, click on the “Create
Default Template” option and SpiraTeam will automatically generate a new XSLT template that displays
just these columns in a nice table format:

Add/Edit Custom Section

[Reqmremenls
select RREQUIREMENT_ID, R.NAME from SpiraTestEntities.R_Requirements as R where R PROJECT_ID = ${Projectld}

You need to enfer the SQL command for retrieving the report data. You can use the special tokens S{Projectid} and S{Frqec:euupm) o limit the query 1o a specific project or project
group. WARNING: I you do not specify either of these: . the report will retrieve data for all projects in of the user's role or

Template:* [<2xml version="1.0" encoding="utf-8"7> -
<xsl stylesheet version="1.0" xmins:xsl="http://www w3 org/1999/XSL/Transform” xmins:msxsl="urn:schemas-microsoft-com:xsh" exclude-
result-prefixes="msxsl">
<xsl:template match="/RESULTS">
<table class="DataGrid"> <tr><th>REQUIREMENT_ID</th><th>NAME </th></tr>
<xsl-for-each select="ROW">

‘You need to enter the XSLT Template for displaying the refrieved data as HTML. When you click the ‘Create Default Template' option, the system will automatically generate a default
XSLT template that you can edit.




You can now click the [Update] button to save your changes to the report.

You may have noticed that we had a special token in the query ${Projectld}, this token will be evaluated
during the generation of the report and ensures that only items in the current project are included. If you
want to include all the items in a specific Project Group, you should instead use the token
${ProjectGroupld}. If you don't use either token, the report will include all the items in the entire system,
across all projects and groups.

For example:

e select value R from SpiraTestEntities.R_Requirements as R where R.PROJECT_ID =
${Projectld}

will display all the requirements in the specific project

e select value R from SpiraTestEntities.R_Requirements as R where R.PROJECT_GROUP_ID =
${ProjectGroupld}

will display all the requirements in the specific project group

e select value R from SpiraTestEntities.R_Requirements as R
will display all the requirements in the entire system

For more information on creating custom report queries, please refer to the knowledge base articles on
the Inflectra customer support website: http://www.inflectra.com/Support.

Warning: If you create a report that doesn’t have either ${Projectld} or ${ProjectGroupld} in the WHERE
clause you could end up displaying data to a user that shouldn’t have permission to see that data.

3.9.4. License Details

The license details page displays the information about the installed license for the particular instance of
SpiraTeam® being used. The information displayed includes: the product name (e.g. SpiraTeam), the
license version (e.g. v4.1.0.0), type of license in effect (x-user fixed, x-user concurrent, demonstration,
enterprise, etc.), the organization that the license belongs to, the actual license key code and finally the
number of users concurrently logged-in. This last piece of information is useful as it helps administrators
track down how many licenses are currently in use.

A sample page is illustrated below:

License Details

Product Type: | SpiraTeam v |

License Version #: vd 0.0.0

License Type: Enterprise License

# Concurrent Users: 1 Active (View Active Sessions)

Expiration: nla

Organization: |Inflectra Corpoeration |

License Key: I |
Note: The license key and organization name must match that found in your Customer Home Page.
If you do not already have a license for the software, you can purchase one online today.
» Update

To change the license key used by the system (for example, if to upgrade from Trial edition to Standard
edition), you do not need to reinstall SpiraTeam®. All you need to do is simply change the information in
the organization and license key text-boxes to match the license key and organization name found in
the customer area of our website (http://www.inflectra.com/CustomerArea) and click the <Update> button.

If there is an issue with the license key (e.g. a trial version that is passed its expiration date, or where the
license key doesn’'t match the organization name) an error will be displayed describing the specific issue
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with the information you entered. If you are unable to get the system to work with the license key
information, please contact Inflectra® customer support at: support@inflectra.com.

3.9.5. LDAP Configuration

As described previously, you can configure SpiraTeam® to use an external LDAP server for importing
new user profiles into the system, and for authenticating users — instead of having to store separate
passwords inside SpiraTeam®. However you need to first configure the LDAP server settings. To do this,
click on the “LDAP Configuration” link the Administration navigation:

LDAP Configuration

This page allows you to configure SpiraTeam to authenticate users against an LDAP directory server. This allows you to avoid having to store passwords in a user's SpiraTeam
profile. You can have both types of user exist at the same time - SpiraTeam users that store their passwords inside SpiraTeam. and LDAP users that use their existing LDAP
passwords

Please view/edit your LDAP server's configuration details below:

LDAP Host™ |myldapserver | Use Secure Sockets Layer (SSL)
Hams (and optionally port) of the server runming LDAP.
(6.0. myserver, myserver 389 or myserver 636)

Base DN™: [CN=Users,0U=Headquarters DC=MyCompany,DC=Com ]
Hams of the raot nade in LDAP from which o search for users (6.9 CN-Users DC-MyCompany DC=Com)
Bind DN |CN=sysadmin, CN=Users, OU=Headquarters, DC=MyCompany DC=Com )

The distinguished name of the user to log into the directory server as (e.g. CN=Fred
Bloggs CN=Users, DC=MyGompany DC=Com) o leave blank for anonymous

Bind Password: [ ]
The password of the user to log into the direclory server as, or leave blank for ananymous i

Attributes

Login*: [uid | First Name [givenName |
The attribute in LDAP holding the legin name The attribute in LDAP holding the user's
i(e.g. uid or sAMAccountName for ActiveDirectory) first name (e.g. givenName)

Last Name [sn | Middle Initial:  [initials |
The attribute in LDAP holding the users i The attribute in LDAP hoiding the users middie
last name (e.g. sn) initials (e.g. initials)

Email Address [mail ]

The atiribute in LDAP holding the user's
email address (e.g. mail}

Sample User

You can optionally enter a sample user to authenticate. When you click [Update] SpiraTeam will try authenticating this user
before it updates the LDAP configuration.

Sample User: [ ]

The distinguished name of 2 sample user you want fo test authenticate (e.g. CN=Fred
Bloggs CH=Users DC=MyCompany.DC=Com)

Sample Password [ ]

You need to fill out the various configuration settings for your LDAP server, each of which is explained in
more detail below:

> LDAP Host
This should contain the name of the LDAP server that you want SpiraTeam to connect to together
with the port number if it's not the default of 389.

» Use Secure Sockets Layer (SSL)
You should select this check-box if your LDAP server requires use of the LDAPS secure protocol.
Leave unchecked for unencrypted LDAP communication.

>» Base DN
This should be the distinguished name of the object inside your LDAP server that contains the list
of user accounts. This varies by the type of LDAP server, please consult your LDAP server
documentation for more details.

> Bind DN
This should be the distinguished name of the user inside your LDAP server that will be used to
authenticate against when importing users. If not provided, SpiraTeam® will try and authenticate
with the LDAP server anonymously.

>» Bind Password
The is the password of the user specified in the Bind DN field above.
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>» Login Attribute
When SpiraTeam® imports users from the LDAP server it needs to know the user attribute inside
the LDAP server that it should use to generate the SpiraTeam® user-name. For most LDAP
servers the appropriate attribute would be “uid”. However for Windows ActiveDirectory, the
attribute “sAMAccountName” should be used instead.

> First Name Attribute
Providing this optional attribute will allow SpiraTeam® to automatically populate the first name
field of the imported user instead of simply using the username as a placeholder.

>» Last Name Attribute
Providing this optional attribute will allow SpiraTeam® to automatically populate the last name
field of the imported user instead of simply using the username as a placeholder.

> Middle Initial Attribute
Providing this optional attribute will allow SpiraTeam® to automatically populate the middle initial
field of the imported user instead of simply leaving it blank.

>» Email Address Attribute
Providing this optional attribute will allow SpiraTeam® to automatically populate the email
address field of the imported user instead of simply using the username@spiratest.com as a
placeholder.

» Sample User
You can optionally enter a sample user and password to test that the user is correctly
authenticated against the server. You can update the LDAP configuration without setting this, but
if you do provide a sample user/password, it will not save the configuration unless the
authentication succeeds. If you choose to enter it, the user’'s name should be the fully-
distinguished name of the user (e.g. CN=Sample User, CN=Users, OU=Headquarters,
DC=MyCompany, DC=Com).

3.9.6. Security Settings

The “Security Settings” administration page lets you specify the various security settings within
SpiraTeam to match your organization’s policies and processes:

Security Settings

This page allows you to modify the SpiraTeam application security settings

Allow User Registration™ [Yes 7 |

Set this to True if you want to allow users to be able fo signup for an account themselves.
5

The number of imes a user can enter an incorrect password before their account geis locked out

Maximum # Invalid Password Attempts*

Minimum Required Password Length*

@

The minimum length of a user's chosen password

Minimum Required Special Characters™ g

The minimum number of nen-alphanumeric characters required in a user's password

Password Attempt Time Window* (10 | minutes

The fime after which a users account gets automatically unlocked
Authentication Expiration™ |30 | minutes

This specifies the amount of ime (in minutes) after vihich a user will be logged out due o inactivity
Keep Me Logged-In Expiration® |2D1E[] | minutes

This specifies the amount of time (in minutes) after which a user will be logged out due to inactivity if they have chosen to login with the 'Keep Me Logged-In' option.

» Cancel |[» Update

The following settings can be changed within the system, once you are satisfied, click the <Update>
button to commit the changes:
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>» Allow User Registration — Set this to “Yes” if you want to allows to self-register for SpiraTeam
accounts (that you can subsequently approve). If you set this to “No”, a system administrator will
need to create all user accounts. Also set this to “No” if you plan on using LDAP-based
authentication.

>» Maximum # Invalid Password Attempts — Set this to the number of times a user can enter an
incorrect password before their account is temporarily locked out. This is important in preventing
‘brute force’ password hacking attempts.

» Minimum Required Password Length — Set this to the minimum length of passwords in the
system. Choosing a longer password will make it harder for an unauthorized user to crack a
password and gain entry into the system.

» Minimum Required Special Characters - Set this to the minimum number of non-alphanumeric
characters that will be required for passwords in the system. Choosing more required special
characters will make it harder for an unauthorized user to crack a password and gain entry into
the system.

>» Password Attempt Time Window — Set this to the duration (in minutes) after which a user’s
account will be automatically unlocked (due to repeated incorrect password attempts).

> Authentication Expiration — This specifies the amount of time (in minutes) after which a user
will be logged out due to inactivity when they login without choosing the ‘Keep Me Logged-In’
option.

» Keep Me Logged-In Expiration - This specifies the amount of time (in minutes) after which a
user will be logged out due to inactivity if they have chosen to login with the 'Keep Me Logged-In'
option. This should normally be longer than the previous setting.

3.9.7. Event Log

The “System Event Log” administration page lets you view all of the errors, warning and other diagnostic
messages that have been logged in the system:

System Event Log
The following system events have been logged in the system
Event Time AV Type 4 ¥ Category AY  Message A Y Event Code 4¥  Operations
\ =] [~ Any - Ml J J [ J
12/26/2012 10:51 PM Error Application Cannot get IIS pickup directory. 0
12/26/2012 10:51 PM Error Application Cannot get IIS pickup directory. 0
12/26/2012 10:51 PM Warning Application User with username 'rsmith’ does not exist in the system 0
12/26/2012 12:08 PM Warning Application User 26 does not exist in the system 0
12/26/2012 12:08 PM Error Application Cannot get IIS pickup directory. 0
12/26/2012 12:08 PM Warning Application User with username 'testuser’ does not exist in the system 0
12/26/2012 12:08 PM Error Application Cannot get lIS pickup directory. 0
12/26/2012 12:08 PM Warning Application User with username 'testuser’ does not exist in the system 0
12/26/2012 12:08 PM Error Application Cannot get IIS pickup directory. 0
12/26/2012 12:08 PM Warning Application User with username 'testuser’ does not exist in the system 0
12/26/2012 12:08 PM Warning Application User 27 does not exist in the system 0
12/26/2012 12:08 PM Error Application Cannot get IIS pickup directory. 0
12/26/2012 12:08 PM Warning Application User with username 'demo20121226-120855437" does not exist in the system 0
12/26/2012 12:08 PM Error Application Cannot get lIS pickup directory. 0
12/26/2012 12:08 PM Warning Application User with username ‘jjones’ does not exist in the system 0 f
Displaying page |17| of3mp
(» Filter | (» Clear Filter |(» Clear Log |

Each event entry is displayed along with the date-time it occurred, the type of event (error, warning,
information, success audit, failure audit), category (application, source code provider, data-
synchronization) and the short name. To view the full message, click on the “View Item” hyperlink:

© Copyright 2006-2014, Inflectra Corporation Page 80 of 96 This document contains Inflectra proprietary information




System Event Log Event Details

The following system events have

Event Time AV

12/26/2012 10:51 PM
12/26/2012 10:51 PM
12/26/2012 10:51 PM
12/26/2012 12:08 PM
12/26/2012 12:08 PM
12/26/2012 12:08 PM
12/26/2012 12:08 PM
12/26/2012 12:08 PM
12/26/2012 12:08 PM
12/26/2012 12:08 PM

Type

Exception: System.Net.Mail. SmtpException

at System Net.Mail.lisPickupDirectory. GetPickupDirectory()
at System.Net.Mail SmtpClient. SendAsync(MailMessage message, Object userToken)
at Inflectra.SpiraTest.Common.MailClient. SendM Maill )

12/26/201212:08 PM  |Waming  Application
12/26/201212:08 PM_ [Emer | Application
12/26/201212.08 PM  |Waming  Application
12/26/201212:08 PM  [Emor  Application
12/26/201212:08 PM |Waming  Application

User 27 does not exist in the system

Cannot get IIS pickup directory

User with username 'demo20121226-120855437" does not exist in the system
Cannot get IIS pickup directory

User with username 'jjones’ does not exist in the system

4 -« Displaying page |1

Event Code AY  Operations

L

View ltem
View Item
View Item
View Item
View ltem
View ltem
View Item
View Item
View Item
View ltem
View Item
View Item
View Item

Ccoo o oo o000 o000 oo

View ltem

=

View ltem

[» Filter ][ Clear Filter |(» Clear Log |

The popup dialog box will display the full error message log and stack trace in a moveable dialog box.
This information should be provided to Inflectra customer support if you log a help desk ticket.




3.10. Integration

3.10.1. Data Synchronization

SpiraTeam® is capable of synchronizing its data with a variety of other systems, including but not limited
to requirements management systems and standalone bug-tracking tools. The various integration plug-
ins for SpiraTeam® and the steps for configuring the data-synchronization settings are described in the
SpiraTest External Bug-Tracking Integration Guide.

If you are synchronizing data between SpiraTeam® and one of these other systems, you can click on the
‘Data Synchronization’ administration page at any time and view a list of all the data-synchronizations
taking place, together with the status and date/time of last synchronization:

Data Synchronization (Refresh)

SpiraTeam is able to communicate with a variety of external systems and applications using its background
data synchronization service and library of available plug-ins.

This page allows you to view, add and modify the list of plug-ins, make changes to their configuration, and
verify the status of the most recent synchronization. In addition, you can force a particular plug-in to perform a
complete data-synchronization by resetting its date of last sync:

Plug-In Data Mapping Last Sync Date Status Operations

BugzillaDataSync w Project Mapp Not Run > Force Re-Sync | Edit | Delete | View Errors
FogBugzDataSync Not Run >Fo Re-Sync | Edit | Del (s
JiraDataSync Not Run > Force Re-Sync | Edit | Del
MsTfsDataSync Mot Run > Force Re-Sync | Edit | Delet

[+ Add

In the example above, we have four plug-ins active, with incidents being exported into JIRA, Bugzilla,
FogBugz and Microsoft Team Foundation Server. The data of last sync and the status indicate if there are
problems with the plug-in.

The ‘Refresh’ link allows you to refresh the status of the page to ensure that you are seeing the most up
to date information. In certain circumstances you may want to reset the date of last sync and force a
particular plug-in to examine all the records in the system to see if any were not synchronized - clicking
on the ‘Force Complete Re-Sync’ will achieve this. The recommended procedure for forcing a re-sync is
to temporarily stop the SpiraTeam Data-Sync background Windows service, click the button to reset the
last-sync date, and then start the service. This will ensure that the resetting doesn’t happen mid-sync.

3.10.2. Version Control Integration (On-Premise Customers Only)

This section refers to the functionality available to on-premise customers of SpiraTeam. If you are using
the cloud / hosted version of SpiraTeam, please refer to section 3.10.4 (TaraVault Configuration) instead.

SpiraTeam® is capable of integrating with a variety of Version Control (VC) / Software Configuration
Management (SCM) tools such as Git, Subversion, CVS and TFS. This allows you to browse the source
code repositories using the SpiraTeam web interface, and more importantly link revisions in these tools to
artifacts in SpiraTeam. This provides the end-to-end traceability from code commits/check-ins to the
tasks, incidents and requirements that necessitated the code change.

The information on using the various version control providers for SpiraTeam® and the steps for
configuring the provider-specific settings are described in the SpiraPlan/Team Version Control Integration
Guide.

To configure a version control provider, you need to click on the Administration > Integration > Version
Control link in the Administration navigation to bring up the list of configured version control providers:
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Version Control Integration

SpiraTeam is able to integrate with a variety of external version control systems using its flexible, open
architecture and library of available version control providers.

This page allows you to view, add and modify the list of version control providers, make changes to their
configuration and also specify any project-specific configuration values:

Provider Description Project Settings Active Operations
TestWersionControlProvider | This provides the dummy version control provider | > Project Settings | Yes = Edit | Delete

used in testing

By default the only provider listed will be the TestVersionControlProvider which is used for demonstration
purposes only, and can be deleted from a production system by clicking on the “Delete” link to the right of
it.

To add a new version control provider, click the “Add” button to enter the Plug-in details page. The fields
required are as follows:

Edit Version Control Provider | New Provider

<< Back to Version Control Home

Please enter/edit the following information for the provider. The exact information that needs to be entered is

specific to each provider, and you should refer to the documentation for the provider when entering/changing
it

Name:* [subversionProvider |
Description

M Active
Default Settings

The following settings are used for any projects that do not define their own settings

Connection Info:* (syn://doctor/Inflectra/Trunk/Templates and Forms

Login:* [usert |

Password:” [passwurd |

Domain:

Custom 01:

Custom 02

Custom 03:

Custom 05:

[
|
(
(
Custom 04 |
(
(

» Insert |+ Insert and Close |

e Name: The name of the version control provider that you're adding. This needs to match the
name of the Plug-in DLL file that you're using (see the SpiraPlan/Team Version Control
Integration Guide for more details on your specific tool)

e Description: The description is for your use only, and does not affect operation of the plug-in.
e Active: If checked, the plug-in is active and able to be used for any project.

e Connection Info: This field holds the root of the repository for any project accessing the plug-in,
unless overridden in the Project Settings. Use the syntax that is described for your tool in the
SpiraPlan/Team Version Control Integration Guide)

e Login/Password: The user id and the password of the user to use while accessing and
retrieving information from the version control system.

e Other Fields: The other fields (Domain, Custom1 — Customb5) are provider-specific and will be
described in the appropriate section of the SpiraPlan/Team Version Control Integration Guide.
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When finished, click the “Insert” button and you will be taken back to the Version Control integration list
page, with new provider listed as an available plug-in:

Version Control Integration
SpiraTeam is able to integrate with a variety of external version control systems using its flexible, open
architecture and library of available version control providers.

This page allows you to view, add and modify the list of version control providers, make changes to their
configuration and also specify any project-specific configuration values:

Provider Description Project Settings Active Operations
SubversionProvider > Project Settings | Yes > Edit | Delete

TestVersionControlProvider | This provides the dummy version control provider | » Project Seftinos | Yes » Edit | Delete
used in testing

To edit the settings for an existing version control provider, just click on the “Edit” link next to the name of

the provider and you will be able to edit the same settings that were shown above when you first created
it.

Now, you may want to change some of the settings on a per-project basis. For example you may have
different repositories that you want to link to each project. You still enter the base settings for the provider
as illustrated above, but then you can override specific settings for each project.

To do this, click on the “>Project Settings” hyperlink next to the provider in question:

SubversionProvider Project Settings | Library Information System [Change Project)

<< Back to Version Control Home

Please edit the following project-specific settings for the "SubversionProvider' version control provider. If you
leave any fields blank, then the value will be taken from the provider's default settings. To stop using this
provider on the project, just set the Active flag to No below:

Project Name:* Library Information System
Active for Project:* [No v
» Update

The first thing you need to do (regardless of whether you'll be overriding any of the settings) is to make
the provider active for the current project. To do this, change the drop-down list to “Yes” and click
[Update]:
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SubversionProvider Project Settings | Library Information System (Change Project)

Project settings successfully updated. ]

<< Back to Version Control Home

Please edit the following project-specific settings for the "SubversionProvider' version control provider. If you
leave any fields blank, then the value will be taken from the provider's default settings. To stop using this
provider on the project, just set the Active flag to No below

Project Name:* Library Information System
Active for Project:* | Yes v |
(+ Update |
Connection Info: [svn:lfdoctor/SpiraTeam
Login: [build |
Password: [remereens | [+ Test
Domain: [ |
Custom 01: [ |
Custom 02: [ :|
Custom 03: [ |
Custom 04: |: :|
Custom 05: [ |
[

» Update | [» Clear Cache |

Now you can decide whether you want to override any of the default settings for this project. Any field left
blank will automatically get its settings from the default values entered earlier. In the example above, we
have specified a project-specific repository path, login and password. Once you have correctly configured
the project, click [Update] to commit the changes.

To improve performance, SpiraTeam will cache some of the data it receives from the version control
provider. Normally SpiraTeam will know when to update the cached data based on changes made in the
version control system automatically. However sometimes you may wish to flush the cached data
completed, to do this, simply click on the [Clear Cache] button.

You are now ready to use SpiraTeam® in conjunction with the version control tool you selected. For
details on how to use the Source Code integration features of SpiraTeam, please refer to the
SpiraTeam® User Manual.

3.10.3. Test Automation

SpiraTeam® can be used to manage the development, scheduling and execution of automated unit,
functional and load tests written using a variety of test automation engines (e.g. HP QuickTest Pro,
SmarteScript, TestComplete, etc.). This section allows you to configure the different engines that are
available in your environment so that the testers know which tools they can use to schedule tests with.

The information on using the various test automation engines for SpiraTeam® and the steps for
configuring the engine-specific settings are described in the SpiraTest/Team RemoteLaunch Automated
Testing Integration Guide.

To configure a test automation engine, you need to click on the Administration > Integration > Test
Automation link in the Administration navigation to bring up the list of configured test automation engines:
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Test Automation Engines

SpiraTeam is able to integrate with a variety of external test automation systems using its flexible, open
architecture and library of available test automation engines

This page allows you to view, add and modify the list of test automation engines and make changes to their
configuration:

Name Token Description Active Operations
Bad Boy BadBoy2 Engine that integrates with Bad Boy No > Edit | Delete
Command- CommandLine Engine that will execute a generic command-line No > Edit | Delete
Line executable
FitNesse FitNesse Engine that integrates with FitNesse framework Mo > Edit | Delete
IBM RFT RTFAutomationEngine | Engine that integrates with IBM Rational Functional No > Edit | Delete

Tester
JMeter JMeter2 Engine that integrates with Apache JMeter No > Edit | Delete
LoadRunner LoadRunner11 Engine that integrates with HP LoadRunner 11.0+ No > Edit | Delete
MNeoload MNeolLoad Engine that integrates with NeoTys NecLoad MNo > Edit | Delete
Quick Test Pro | QuickTestPro9 Engine that integrates with HP Quick Test Pro 9.0+ Yes > Edit | Delete
Ranorex RanorexEngine Engine that integrates with Ranorex No > Edit | Delete
Rapise Rapise Engine that integrates with Inflectra Rapise Yes = Edit | Delete
Selenium RC Seleniumi Engine that integrates with the open-source Selenium MNo > Edit | Delete
RemoteContrel (RC) 1.0
SmarteScript SmarteScripth Engine that integrates with SmarteSoft SmarteScript Yes > Edit | Delete
5.5+
SOAP-UI SoapUl Engine that integrates with SmartBear SOAP-UI No > Edit | Delete

TestComplete | TestComplete8 Engine that integrates with SmartBear TestComplete No > Edit | Delete

8.0+

TestPartner TestPartner Engine that integrates with MicroFocus TestPartner No > Edit | Delete

To add a new test automation engine, click the “Add” button to enter the Automation Engine details page.
The fields required are as follows:

Edit Automation Engine | New Engine

=< Back to Test Automation Engine Home

Please enter/edit the following information for the test automation engine. Required fields are indicated in
bold:

Name:* |

Description:

Token:* ( |

W Active
(» Insert |(» Insert and Close |

e Name: The name of the test automation engine that you're adding. This can be set to any name
of your choice that would make sense to your users.

e Description: The description is used for any comments or additional information that you need to
use to describe the automation engine.

e Active: If checked, the automation engine is active and able to be used in any project.

e Token: This needs to match the name of the Automation Engine DLL file that you're using (see
the SpiraTest/Team Automated Testing Integration Guide for more details on your specific tool)
for the specific automation engine.

When finished, click the “Insert” button and you will be taken back to the test automation engine list page,
with new automation engine listed.

To edit the settings for an existing test automation engine, just click on the “Edit” link next to the name of
the engine and you will be able to edit the same settings that were shown above when you first created it.
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Edit Automation Engine | Quick Test Pro

<< Back to Test Automation Engine Home

Please enter/edit the following information for the test automation engine. Required fields are indicated in
bold:

Name:* \'Ouick Test Pro

Description:  [Engine that integrates with HP Quick Test Pro 9.0+

Token:” \:OuickTestProg \

M Active
(» Update |(» Update and Close |

Once you have made the appropriate changes, click the [Update] button to commit them.

You are now ready to use SpiraTest® / SpiraTeam® in conjunction with the test automation engine you
added. For details on how to use the test automation features of SpiraTeam, please refer to the
SpiraTeam® User Manual.

3.1.0.4. TaraVault™ Integration

This section refers to the functionality available to hosted/cloud customers of SpiraTeam. If you are using
the on-premise version of SpiraTeam, please refer to section 3.10.2 (Version Control Integration) instead.

TaraVault™ is the hosted source code repository and software configuration management (SCM) system
provided by Inflectra. When you signed-up or purchased a subscription to either SpiraPlan or SpiraTeam,
it will have come with an entry-level subscription to TaraVault.

When you first click on the Administration > TaraVault administration page, you will see the following
screen:

TaraVault Configuration | Library Information System (Change Project)

TaraVault is the hosted source code repository and software configuration management (SCM) system provided by Inflectra.
Projects in SpiraTeam can be enabled in TaraVault for storage of project source code files and revisions. TaraVault is provisicned based on a specific number of active users.

You can change which users are active for source code management in the View / Edit Users screen

Your TaraVault instance is not active. Once activated you will need to create a TaraVault project for any SpiraTeam
project that you want to set up a version control repository for. You may activate TaraVault by clicking the button below.

» Activate TaraVault

This lets you know that you have not yet activated your TaraVault account with Inflectra. When you click
on the [Activate TaraVault] button you will see the following:

TaraVault Configuration | Library Information System (Change Project)

TaraVault is the hosted source code repository and software configuration management (SCM) system provided by Inflectra
Projects in SpiraTeam can be enabled in TaraVault for storage of project source code files and revisions. TaraVault is provisioned based on a specific number of active users|

You can change which users are active for source code management in the View [ Edit Users screen.

TaraVault Global Settings
Available TaraVault Users: &
TaraVault Account Name:  localhost

TaraVault Project Settings
TaraVault Project Active: No
TaraVault Project Name: (

TaraVault Project Type: |5\fN v

» Activate
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This will let you see how many TaraVault SCM users your subscription allows and also the name of the
TaraVault instance that your SpiraTeam instance is associated with.

Each project in SpiraTeam has its own corresponding TaraVault project, and each TaraVault project can
be configured to use one of the two different SCM providers:

e Subversion (SVN) — This is a simple, centralized version control system (VCS) that works best
for teams that want to have a centralized SCM environment with only one central instance of the
SCM repository. Subversion only allows a single branch to be managed and is generally easier to
understand conceptually.

e Git — This is a more powerful, distributed version control system (DVCS) that works best for
teams that want to have multiple distributed instances of their source code repository. Git offers
superior merging and branching functionality to Subversion but is generally more complicated to
understand conceptually.

For the current SpiraTeam project you can choose the type of provider you wish to use, enter the name of
the TaraVault project and click Activate:

TaraVault Configuration | Library Information System (Change Project)

[TaraVault is the hosted source code repositery and software configuration management (SCM) system provided by Inflectra.
Projects in SpiraTeam can ke enabled in TaraVault for storage of project source code files and revisions. TaraVault is provisioned based on a specific number of active users.

'You can change which users are active for source code management in the View / Edit Users screen

Message from webpage s
TaraVault Global Settings
Available TaraVault Users: 5 '6‘ Oncethe project is activated, ne changes can be made to its
TaraVault Account Name:  localhost LW configuration. Are you sure you want to activate this Project?
""" ilt Project Settings

TaraVault Project Active: No

TaraVault Project Name: \.leraw |

TaraVault Project Type EL v|

» Activate

Since you cannot change the type or name of the TaraVault project once activated, please review your
entries and click [OK] to confirm the new project activation.

Once the project activation has been completed, the screen will display the following:

TaraVault Configuration | Library Information System (Change Project)

TaraVault is the hosted source code repository and software cenfiguration management (SCM) system provided by Inflectra
Projects in SpiraTeam can be enabled in TaraVault for storage of project source code files and revisions. TaraVault is provisioned based on a specific number of active users

You can change which users are active for source code management in the View / Edit Users screen.

TaraVault Global Settings
Available TaraVault Users: 5
TaraVault Account Name:  localhost

TaraVault Project Active: Yes

TaraVault Project Nams: (L jbrary

TaraVault Project Type:  Subversion

» Deactivate » Clear Cache

Users assigned to this project

Full Name 4 ¥ User Name AY TaraVault Login A¥  Operations
( ] | | |

No users selected for this project. Add Users..

The screen will display the name of the linked TaraVault project as well as the list of TaraVault SCM
users that are configured to use this TaraVault project — this list will not necessarily be all of the users in
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the SpiraTeam project, just those that need to connect to TaraVault to commit source code into the
repository.

If you want to deactivate this TaraVault project, click the [Deactivate] button and the project will be
removed from TaraVault.

To improve performance, SpiraTeam will cache some of the data it receives from TaraVault. Normally
SpiraTeam will know when to update the cached data based on changes made in TaraVault
automatically. However sometimes you may wish to flush the cached data completed, to do this, simply
click on the [Clear Cache] button.

To add new SCM users to the TaraVault project, simply click on the ‘Add Users’ link to add new SCM
users to the project.

3.10.5. Add-Ons and Downloads

In addition to the web interface that is typically used to interact with SpiraTeam®, there are a variety of
downloadable tools and extensions that allow SpiraTeam® to be used in conjunction with other
applications, and also to enable the migration of data from other systems into SpiraTeam®.

To view the list of available add-ons and downloads, simply click the “Add-Ons and Downloads” link in the
Administration navigation sidebar and you will be taken to the page on the Inflectra® website that lists the
various add-ins for the system, together with links to the appropriate documentation.
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4. Appendices

4.1. Appendix A — Troubleshooting

If you receive the dreaded “IIS 500 Internal Error” or the “Server Application Not Available” webpage
when you try and access SpiraTeam® for the first time, there can be a myriad of causes. However a good
first place to look for the cause is inside the Windows Event Viewer, which stores all errors raised in the
system.

To open the Event Viewer, click Start > Settings > Control Panel > Administrative Tools > Event Viewer.
This will open up the event viewer:

B Event Viewer = | x
File Action View Help
& o |m=| B 2

@ Event Viewer (Local)

3| Application

3| Security :

3| System %il?Applimﬁon Log Application Error Records 512.0KB |

4| Internet Explorer Security Log Security Audit Records 64.0 KB
System Log System Error Records 128.0KB
Internet Explorer Log Custom Log Error Records

Mame Type Description Size

Click on the Application and System folders in turn and look for errors raised by “MSSQLSERVER”,
“SpiraTest”, “SpiraTest DataSync Service”, “DCOM”, “ASPNET” or “lIS”. Click on the error message, and
copy the text of the message into a text editor (e.g. Notepad).

Before contacting Inflectra® customer support with the specific error message, here are a couple of
common causes for the above errors together with the appropriate resolutions:

» The ASP.NET process account has been disabled (Windows XP only)
Go to Start > Control Panel > Administrative Tools > Computer Management and launch the
Windows computer management console. Expand Local Users and Groups > Users and then
double-click on the '"ASPNET' account. Make sure that the ASPNET user is not disabled.
This only applies to installing SpiraTeam on Windows XP. For other versions of Windows, the
ASPNET user is set per-application pool and typically is set to the built-in NETWORKSERVICE
account, so this won't apply.

» The ASP.NET process account does not have sufficient permissions
Right-click on the C:\WINDOW S\Microsoft. NET\Framework\v4.0.30319 folder (and any other
versions of .NET that are listed) and make sure that the ASPNET, NETWORKSERVICE and
LOCALSERVICE accounts are all listed with Full Control. If that doesn't fit the issue and you are
using Windows Server, open up the 1IS manager and right-click on the Application Pool that
SpiraTeam® is running under and make sure that the identity listed has Full Control permissions
on the same folders.

» The Windows Event Log is full
Open up the Application and System event logs, right-click on the log hame and choose
Properties. Make sure that both are set to “overwrite events as needed”. If they are not set to
overwrite as needed, change the setting then manually clear both logs.

If the resolutions above were not able to resolve the issue, please send an email to
support@inflectra.com and include the error message from both the web page and the Windows Event
Logs.
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4.1.1. Missing MSDTC Issue

There is one common error that has been found with installations where Microsoft SQL Server was
installed after 1IS was installed. This typically affects only Windows XP Professional, but could occur in
other situations. What happens is that the SQL Server installation inadvertently removes the Microsoft
Distributed Transaction Coordinator (MSDTC) service from the system during the installation.

To determine if this is indeed the cause of the observed error, you need to click on Start > Settings >
Control Panel > Administrative Tools > Component Services:

i#; Component Services
@ Eile Acton View Window Help ;@IJ
& - @@ 2 =

[L] Consale Root
= @ Component Services 1
=1-[_1] Computers D m D
—g My Computer
=- .D COM+ Applications Components Legacy Roles
-2 COoM+ Explorer Components
£ % COM+ QC Dead Letter Queue Listener
- COM+ Utlities

= g {8 In:Process Applcations |

115 Out-Of-Process ﬁa;iéa“»‘-\uplicaﬁuns
&% 115 Utiities
- System Application

&2 DCOM Config

&[] Distributed Transaction Coordinator |

-

Once the window has opened, expand the folders marked “Component Services”, “Computers”, “My
Computer” and “COM+ Applications” in turn. If the window opens correctly and displays the information
illustrated above, then your IIS 500 error is being caused by something else.

However if you receive an error message that indicates an inability to connect with the “Distributed
Transaction Coordinator”, then you have to fix the MSDTC service to enable 1IS and ASP.NET to operate

properly.
To fix the issue, you need to make changes to the Windows System Registry (hereafter referred to as “the

registry”). This is a process that should not be attempted by novice users, since any incorrect changes
can complete wreck the Windows installation, requiring a complete reinstallation of the operating system.

To open the registry, click Start > Run, and type “Regedit.exe” into the dialog box, and the registry will
open:

% Registry Editor
File Edit View Favorites Help

[ MsDarPP Al Name Type —
& msDn [Default) REG_SZ {value not set)
a AIIDWOnIySecureRchaIIs REG_DWORD 0x00000001 (1)
= MSE. . Clusteringl-'ersion REG_DWORD OxfFFAFFF (4294967295)
% mg:;ansmg Fallbad(ToLlnsecureRPCIﬁ"l... REG_DWORD 0x00000000 {0)
(3 MSNInstaller MaxLDQSize REG_DWORD 0x00000200 (512)
[ msos04P TurnOf-FRpcSecurity REG_DWORD 0x00000000 (0)
(L1 Ms5QLServer e
< > < >

My Computer\HKEY_LOCAL_MACHINE\SOFTWARE MicrosoftMSDTC

Expand the folders marked “My Computer”, “HKEY_LOCAL_MACHINE", “SOFTWARE" and “Microsoft” in
turn and navigate to the folder marked “MSDTC". Click the <Delete> button on your keyboard, and click
<OK> on the confirmation box. Now close the registry editor.

Now you need to click on Start >Settings > Control Panel > Add or Remove Programs and click on the tab
marked “Add/Remove Windows Components”:
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Windows Components Wizard

Windows Components

You can add or remove components of Windows XP.

To add or remove a component, click the checkbaox. A shaded box means that onby
part of the component will be installed. To see whiat's included in a component. click

Details.

Components:

~
@Fax Services 3.8MB

FP Indexing Service 0.0MB
élrﬂeme‘t Explorer 0.0 MB

W B Intemet Information Services (1151 135 MR

Description:  Includes Windows Accessories and Utilities for your computer.

Total disk space required: 56.3 ME
Space available on disk: 33370.1 MB

[ < Back “ MNead = ] [ Cancel ]

Don't change any of the selected components, but instead simply click the <Next> button. The Windows
installer will detect that the MSDTC is missing (due to the registry change you made) and will now
reinstall it correctly. Once this has finished, reboot the system and you should now be able to access ASP
and ASP.NET applications from within IIS.

4.1.2. Application Session Pooling Issues (1IS 6.0)

This issue can affect Windows Server 2003 using IIS 6.0. Since the 6.0 release of IS, there is the ability
to separate the web-server into different “Application Pools”. Sometimes, web hosting companies will host
multiple websites in the same application pool (which we do not recommend). When resources are
maxed out for an application pool IIS 6 starts to recycle these sites causing application variables to be
lost for those recycled sites. By default, SpiraTeam installs on these operating systems in its own
application pool.

If you are experiencing application/session loss symptoms then we recommend asking your web
hosting company to verify that your instance of SpiraTeam is running in its own application pool with all
recycling options disabled and the recycle worker process set to recycle only once during the day at a set
time.

To make these changes yourself, you need to follow these steps:

1) Add new application pool for “SpiraTeam” if one does not already exist:

t Internet InfFormation Services (lI5) Manager ]
rg File  Action Wwiew ‘Window Help — =2
|m| B 2 2

?_J iInternet InFormation Services : Computer Local Wersion Status
=10 INFLECTRASYROS (local computer) LU INFLECTRASYROS (local carnputer)  Yes 115 ¥6.0
=I-__l Application Panls
‘-l!.‘:‘ Defa Tdew 3 Application Paoal. ..
H-gli Spirs Al Tasks » Application Poolfram File). ..
+-pis Stshu

-

: ‘.;!‘:‘ Sradu Mew Window From Here

g
gt SESAL Refresh . .
degh RS 4 Click it and enter the name

5
+
kX
5
+
gl TFSv  Properties of your own application pool.
Hgi TFSW
_d

Help

+] Default Web Site

+ - SharePoint Central Administration
-§- - Team Foundation Server

: Sharepoint Sites

+
__1 web Service Extensions
29 Default SMTP Virtual Server

Create Application Pool

2) Next, choose your own application pool in the SpiraTeam web site properties:
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Default Web Site Properties ? !

Directory Security HTTP Headers Zuskom Errors ASP.MET
Wb Sike Performance ISAPI Filtars Horne Directory Documents

The content For this resource should come From:

(@ directory located on this computert
() & share located on another computer
) A redirection to a URL

Local path: c:hinetpubipnsaroot
I:l Scripk source access Log wisits

Read Index this resource

[ werite

Choose the application

[ birectory browsing
pool you created before

Application settings

Application name: Default Application  #
Starting poink: <Default Web Sited
Configuration. ..
Execute permissions: Scripts only y hd
Application poal: SpiraTest dl
——

Click <OK> and you should now find that the issues with sessions disappearing has been corrected.

4.1.3. Application Session Pooling Issues (IIS 7.0+)

This issue can affect Windows Vista, 7, 8 or Server 2008, 2012 using IIS 7+. In lIS 7.0+, there is the
ability to separate the web-server into different “Application Pools”. Sometimes, web hosting companies
will host multiple websites in the same application pool (which we do not recommend). When resources
are maxed out for an application pool IS 7 starts to recycle these sites causing application variables to be
lost for those recycled sites. By default, SpiraTeam installs on these operating systems in its own
application pool.

If you are experiencing application/session loss symptoms then we recommend asking your web
hosting company to verify that your instance of SpiraTeam is running in its own application pool with all
recycling options disabled and the recycle worker process set to recycle only once during the day at a set
time.

To make these changes yourself, you need to follow these steps:

Add new application pool for “SpiraTeam” (if one does not already exist) and make sure it is set to use the
.NET Framework v4.0 and the “Integrated Pipeline”:

"-'Elnternet Information Services (IIS) Manager A=l E3
&Y 2} ~ INFLECTRASYRO4 - Application Paols 1) @ -
s s

File Miew Help

UJ' Application Pools

4=y Add Application Pool..

%5 Start Page Set Application Pool Defaults...,
Fl!-“-; INFLECTRASYRO4 (IMFLECTRAL This page lets you view and manage the list of application pools on the server, Application pools are associated with EM
A e IE G worker processes, contain one of more applications, and provide isolation among different applications, @ Help
el A pplication Pacls ¥ -
- @] Sites |: Add Application Pool... | ~ (G~ 5l show Al | Group byi o Grouping - Orlire: Help
&3 Refresh | Status | MET Frame. .. I Managed Pipeli... | Identik: | Applications
T AR Started w20 Classic MetworkService o
Integrated MetworkService z

Click it and enter the name
of your own application pool.

< | _'I

Ready G_El:;

Next, choose your own application pool in the SpiraTeam web site properties:
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Advanced Settings

“E Internet Information Services (I15) Manager [ICR{CSICEIN
@!ﬁ [3 + INFLECTRASYRO4 = Shes = =

Physical Path Credentials
Physical Path Credentials Logon Type ClearText,

Yirkual Path [SpiraTe:
’ / b Behavior

Enabled Protocols http

Eile  ¥iew Help

]

& Explore

Edit Permissions. ..

-l Start Page
€3 INFLECTRASYRO4 (INFLECTRAadas
application Pools

Basic Settings...

=-[a] Sites _ View Virtual Directories
=69 Default web sits s Choose the application — =
t_clisnt M Applicati (~
d L pool you created before it Ao -

piraTes! Browse Application

Browse *:80 (http)

Authenticati sk
= advanced Settings...
= @ heb
- Orline Help
Handler
Mappings

ey
¥ [l

ot Application Pool
[applicationPool] Configures this application ka run in the specified application poal.
| » E Features ¢

Ready L

Ok Cancel

.




Legal Notices

This publication is provided as is without warranty of any kind, either express or implied, including, but not
limited to, the implied warranties of merchantability, fitness for a particular purpose, or non-infringement.

This publication could include technical inaccuracies or typographical errors. Changes are periodically
added to the information contained herein; these changes will be incorporated in new editions of the
publication. Inflectra® Corporation may make improvements and/or changes in the product(s) and/or
program(s) and/or service(s) described in this publication at any time.

The sections in this guide that discuss internet web security are provided as suggestions and guidelines.
Internet security is constantly evolving field, and our suggestions are no substitute for an up-to-date
understanding of the vulnerabilities inherent in deploying internet or web applications, and Inflectra®
cannot be held liable for any losses due to breaches of security, compromise of data or other cyber-
attacks that may result from following our recommendations.

The section of the manual that describes modifying the Windows System Registry (“Registry”) should only
be attempted by experienced Windows administrators who are familiar with its organization and contents.
Inflectra® cannot be held liable for any losses due to damage to the system registry made by
inexperienced personnel.

SpiraTest®, SpiraPlan®, SpiraTeam® and Inflectra® are registered trademarks of Inflectra Corporation in
the United States of America and other countries. Microsoft®, Windows®, Explorer® and Microsoft
Project® are registered trademarks of Microsoft Corporation. All other trademarks and product names are
property of their respective holders.

Please send comments and questions to:
Technical Publications
Inflectra Corporation
8121 Georgia Ave
Suite 504
Silver Spring, MD 20910
US.A.

support@inflectra.com
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